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Important
The following functions are for reference only. Some series products may not
support all the functions listed below.



1 Network Config

1.1 Network Connection

Network camera and PC connection mainly has two ways, see Figure 1- 1 and Figure 1-2.

ar cable

IPC

Figure 1- 1

..--"'"'-#

cable \cable

__— switch or

. router
‘3 ’
I

PC

Figure 1-2

Before you access network camera via the Internet, you need to have its IP address. User can use
Config Tool to search IP of the network camera. Please refer to Config Tool manual.

1.2 Login

It needs to install WEB plug-in when you use WEB client for the first time, the exact operation steps are

shown as follows:
Open IE and input network camera address in the address bar. (The factory default IP address is

192.168.1.108).



After successful connection, the login interface is shown as in Figure 1-3; input your user name and

password. Default factory username is admin and password is admin.

IP Camera

Username:

Password:

Login | I Cancel

Figure 1-3

The system Wpdatd P add sswd radyo fipr o mp t

password and save it properly.

b ox

§ reed toynmdify thef @ r s t

First login, suggest updating password.

New Password I

Confirm Password

("] Don’'t show me again

Ok

Cancel

Figure 1-4

After successful login, you may see the interface shown as in Figure 1-5.
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@ Please click here to download and install the plug-in
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Figure 1-5

Click on fAPlease click heuge ntoa ddhwnlisyad eann ¢ oiprss tugpl N
to ask you whether run or save this plug-in. See Figure 1-6.

Do you want to run or zave this file?

MHame: webplugin.exe
Type: application, 1.08ME

From: 10.10.4.198

Run JI Save ][ Cancel ]

i 2 While files fram the Intermmet can be useful, thizs file type can
s ! | potentially harm pour computer. IF wou do not trust the source, do not
“=7un ar zave this software. What's the risk?

Figure 1-6



You must either run or save the file to local and install it. Follow the following steps. Click on run, you
will see Figure 1-7and Figure 1-8.

Ready to Install
Setup is now ready to begin instaling webplugin.exe on your computer,

Click Install to continue with the installation,

[ Install

Figure 1-7



Installing
Please wait while Setup installs webplugin,exe on your computer,

Registering files...

Cancel

Figure 1-8

When plug-in installation completes, the installation page closes automatically. The web-end will refresh
automatically, and then you can view video captured by the camera.

IP Camera
| uainsveam_| protoco IS OB = B

Figure 1-9



2 Live

After you logged in, you can see the live monitor window. See Figure 2-1.

IP Gamera IS S s T T
Main Str Sub Stream 1 Sub Stream 2 [ICIN] e Rty = N, c i A
1 [ suvsvcam ] swosveam2 REREJTCP ]

Figure 2-1

There are four sections:

Section 1: Encode setup bar

Section 2: System menu

Section 3: Window function option bar
Section 4: Window adjust bar

2.1 Encode Setup

Note: Some ser isabsstredroidt support
The encode setup interface is shown as in Figure 2-2.

Sub Stream 1 Sub Stream 2 Protocol m

Figure 2-2

Please refer to the following sheet for detailed information.




Parameter Function

Click it to enable main stream video monitoring and click again
to disable it. Generally for storage and monitor.

Sub Stream 1 Click it to enable Sub Stream 1 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

Sub Stream 2 Click it to enable Sub Stream 2 video monitoring and click again
to disable it. When network bandwidth is insufficient, it
substitutes main stream for monitoring.

You can select stream media protocol from the dropdown list.
There are three options: TCP/UDP/Multicast

Main stream

Protocol

2.2 System Menu

System menu is shown as in Figure 2-3.
Please refer to chapter 2 Live, chapter 3 PTZ, chapter 4 Playback, chapter 5 Setup, chapter 6 Alarm,
chapter 7 Log out for detailed information.

r Live T PTZ Fl,albank T Setug T Alarm Lnﬁnut ]
Figure 2-3

2.3 Video Window Function Option

The interface is shown as below. See Figure 2-4.

Figure 2-4
Please refer to the following sheet for detailed information.
SN Parameter Function
1 Relay-out It shows if there is any alarm output, status description is as
follows:

Red: means there is alarm output.
., Grey: means alarm is over.
Click on the button to force alarm to be on or off.
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2 Digital When the video is in the original status, click it you can
Zoom select any zone to zoom in. In the non-original status,
you can drag the zoom-in zone in specified range. Right
click mouse to restore previous status.
Click it; you can use the middle button of the mouse to
zoom in/out the video size.
3 Snapshot Click on the button to snapshot, save picture to path in Ch.
5.1.2.5.
4 Triple Click it to take snapshot upon the video at the frequency of
snapshot one picture per second. All images are saved to path in Ch
5.1.2.5.
5 Record Click it to record the video. All videos are saved to path in
Chapter 5.1.2.5.
6 Easy focus | Click it, you can see there are two parameters on the preview
video' AF Peak and AF Max.
AF Peak: It is to display the video definition during the focus
process.
AF Max: It is the most suitable value for the video definition.
The close the AF Peak and AF Max is, the better the focus
effect is.
7 Audio Turn on or off audio when you are monitoring.
8 Talk Click it to start or end bidirectional talk.
9 Help Click it to open help file.

2.4 Video Window Setup

The interface is shown as in Figure 2-5.

2.4.1 Image Adjustment

w0 = to it ©

ONONONONONONONO)

Figure 2-5

See Figure 2-6 for image adjustment.




Figure 2-6

Click this button to display/hide image control interface. Click it to open picture setup interface. This
interface is on the top right pane.

Please refer to the following sheet for detailed information.

Parameter Function

Video It is to adjust monitor video Note:

setup brightness. All the operations here apply
to WEB end only.

Please go to Setup-

B

m It is to adjust monitor video

contrastness. >Camera->Conditions to
E It is to adjust monitor video adjust corresponding items.
hue.

E It is to adjust monitor video
saturation.

Reset | Restore brightness,
contrastness saturation and
hue to system default setup.

2.4.2 Original Size
Click this button to go to original size. It is to display the actual size of the video stream. It depends on
the resolution of the bit stream.

2.4.3 Full Screen
Click it to go to full-screen mode. Double click the mouse or click the Esc button to exit the full screen.

9



2.4.4 Width and Height Ratio
Click it to restore original ratio or suitable window.

2.4.5 Fluency Adjustment
There are three levels of fluency for you to select (Realtime, Normal, and Fluency). The default is
normal.
2.4.6 Rules Info
Click the button, preview image will display intelligent rules after enabling; itisfenabled by def aul t
2.4.7 Zoom and Focus
Click this button and the focus zooming interface appears on the right of preview interface, as shown in
Figure 2-7, click left mouse button to adjust focus zooming configuration.
Note:
¥ The product series which support motorized zoom, synchronous focus and back focus have this
button.
¥ Auto-focus after zoom and focus adjustment.
2.4.8 Fisheye/Trigger Track
Click the button, installation mode and display mode interface will show up on the right of the preview
interface, see Figure 2-8 and Figure 2-9, single click to switch different installation mode and display
mode, or different display modes, it is enabled by default.
Note:
It is only supported by some models.

Zoom and Focus

Restore All

Regional Focus

Figure 2-7
1C



Parameter | Function

Z00m Adjust the focal |l ength of theébluémnsnky
Step length is used to adjust the length of one step with one click.

Focus Adjust the sharpness of the drfnsulty omlsi.
Step length is used to adjust the length of one step with one click.
Click to adjust the image definition automatically.

Auto- Note:

focus ' ) _
Other lens operations are not allowed during the process of auto-focus.
Reset the lens to zero position to eliminate the accumulative error of lens.

Reset All Note:
Please reset when the image adjustment is not clear or operating zoom focus many
times.

Refresh Synchronize the location of drag slider of lens and zoom focus after hardware zoom
focusing.

Regional Click it and use the mouse to select a zone, then the device can auto focus within the

Focus specific region.

-
5

Installation Mode

Display Mode

In-ceiling Mount Wall Mount Ground Mount

Installation Mode Installation Mode

c’g

il

11



Figure 2-8

parameter

Note

Installation Mode

Three modes which are ceiling mount, wall mount and ground mount.

Display Mode

It represents the display mode of the current image (default supports original
image mode), the display modes may be different according to different
installation modes. It is shown as follows:

Ceiling: 1P+1a 2Pa 1+2a 1+3a 1+4a 1P+6a 1+8A
Wall: 1Pa 1P+3a 1P+4a 1P+8A
Ground: 1P+13 2Pa 1+33a 1+4a 1P+6a 1+8A

Note:

The default displays original image mode when switching installation mode.

In-ceiling/Wall/Ground

O

image

Original

It menas the original image without de-warpping

In-ceiling/Ground

1P+1

360°expanded rectangular panorama + independent
sub image, the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.

il

2P

Two related 180° expanded rectangular pictures, two
subwindows form 360° panorama anytime, which is
al so call ed fidual pano
rectangular pictures both support left and right
movement starting point, which are also linked by
eachother.

O
]

Original image + 2 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation (no such
display mode for ground installation).

3]

Original image + 2 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

1+4

Original image + 4 independent sub images, both the
sub image and the subbox in the original image
support zoom and movement. The original image also
supports changing starting point by rotation

12




parameter Note

360&xpanded rectangular panorama +6 independ ent
sub image, both the sub image and the subbox in the
expanded rectangular panorama support zoom and
movement, for the expanded rectangular panorama
also supports left and right starting point movement.
Original image + 8 independent sub images, both the
sub image and the subbox in the original image
= 1+8 support zoom and movement. The original image also
supports changing starting point by rotation

1P+6

Ir’)

From left to right 180° expanded rectangular
panorama, which supports up and down movement
1P and changes vertical angle of view.

Dol

180° expanded rectangular panorama+3 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
.. 1P+3 and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.
180°expanded rectangular panorama+4 independent
sub images, both the sub images and the sub box in
IEEE the expanded rectangular panorama support zoom
1p+4 | @nd movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.
180°expanded rectangular panorama+8 independent
sub images, both the sub images and the sub box in
the expanded rectangular panorama support zoom
1P+8 and movement, expanded rectangular panorama
supports up and down movement and changes vertical
angle of view.

X
||

Wall

&

i

Display Mode

Al W5
...'_.II'

Figure 2-9

Enable the trigger track on the interface of tripwire or intrusion, and draw the rule of tripwire or intrusion,

the scene of trigger track window will change according to the moving object when it triggers rule alarm

until the moving object disappears from the view range of the camera. P| ease r e41¢30 f @ri5.
more details about the rules drawing and parameter config of tripwire and intrusion.

Trigger track includes three modes which are 1P, 1P+3 and 1P+5.

13



E 1P: Original picture

1P+3: Original picture and three trigger track windows, it can adjust the location and size of

three trigger track windows on the original picture.

| 1P+5: Original picture and five trigger track windows, it can adjust the location and size of

five trigger track windows on the original picture.

14



3 PTZ Control

Here you can view direction keys, speed, zoom, focus, iris, preset, tour, pan, scan, pattern, aux on, off
and PTZ setup button. See Figure 3-1.

Note:

Before PTZ operation, please make sure you have properly set PTZ protocol. (Please refer to Ch. 5.5.3).
Currently only IPC-HFXXXX series and i PT series products can support PTZ function.

Parameter Note

PTZ supports eight directions: left/right/up/down/upper left/upper
right/bottom left/bottom right.

It controls rotation speed. The longer the step length, the higher the speed.
Step length control PTZ, zoom, focus and iris.

Use mouse to draw a box in monitoring video, PTZ will rotate and focus to
Quick Position | quickly positioning.

PTZ direction >

Speed

IP Camera

PTZ Settings

Figure 3-1

15



©00
0®O0
00O

speed(1-8): 4

© = ©

e Focus e
© - O
PTZ Settings

Figure 3-2

PTZ setting interface is shown as in Figure 3-3.
Here you can set scan, preset, tour, pattern, assistant function and light and wiper plus view coordinate.

3.1 Scan

Scan interface is shown in Figure 3-4.

PTZ Settings

Figure 3-3

16



PTZ Settings

Scan

P Start B Stop

2 Set

Set Left Set Right

Figure 3-4

Steps to scan are:

Set Left Set Right

Step 1. Click on Set button, display icon.

Step 2. Move via direction key to select left, click on Set Left to set left border of camera
Step 3. Move via direction key to select right, click on Set Right to set right border of camera.
Step 4. Complete scan path setup.

3.2 Preset

Preset interface is shown in Figure 3-5.
PTZ Settings

Figure 3-5

Steps to preset are:

Step 1. In preset box, input preset value.

Step 2. Click on Go to, camera rotates to preset position.

Step 3. Use direction key to rotate camera, and in preset box input preset value.
Step 4. Click on Add to add a preset. Range of preset relates to PTZ protocol.

3.3 Tour

17



Tour interface is shown in Figure 3-6.

PTZ Settings

P Start W Stop

Figure 3-6

Steps to tour are:

Step 1. In tour box, input tour path value.

Step 2. Click on Add. Range of tour relates to PTZ protocol.
Step 3. In preset box, input preset value.

Step 4. Click on Add as to add a preset in this tour. If click on Del, it deletes this preset in tour.

Note:
You can add more than one preset here, or delete more than one preset.

3.4 Pattern

Pattern interface is shown in Figure 3-7.

PTZ Settings

-5
EZIETR

Figure 3-7
Steps to set pattern are shown as follows:
Step 1
l nput pattern serial number value in the box,
Step 2
Click AStart RecO toperationsmslceaneoorh, foeus, Big directoa and o on.

Step 3

c |

c k



Click AStop Reco to complete the setting of a patte
Step 4

Click AStarto and it will start pattern according t
the pattern ends.

3.5 Assistant

Assistant interface is shown in Figure 3-8.

PTZ Settings

Agsistant

Aux On Alx Off

Figure 3-8

Steps to assistant are:

Step 1. In assistant box input assistant value.

Step 2. Click on Aux On to turn on aux function.
Click on Aux off to turn off aux function.

3.6 Light Wiper

Light wiper interface is shown in Figure 3-9.

Enable Disable

Figure 3-9

Steps to light wiper are:
Click on Enable to enable light wiper function.
Click on Disable to disable light wiper function.

B

B
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4 Playback

Web client playback supports video playback and picture playback.
Note:
Before playback, user shall set storage management as in Ch. 5.4.

4.1 Playback

The playback interface is shown as in Figure 4-.

IP Camera (ST S IR SR TR TR
SO @

FroTpe
[PEEE SD Card [~}

e < RS

Sun Mon Tue Wed Thu Fri Sat

1
2131456 7]8
9 J1Oj11]12§13]14]15

161718 19 20 21 22

232425 26 27 28 29

3D

Record Type Al General B Motion Il Alarm Manual B

There are four sections:

Section 1: Function of play
Section 2: Playback file
Section 3: Play time cut
Section 4: Record type
Section 5: Progress bar
Section 6: Assistant function




4.1.1 Function of Play
The function of play is shown as in Figure 4-2 and Figure 4-3.

OC0000 O =0

©Oe e 6 6 O 6-1

Figure 4-2

00000 O =0

e e 6 ©® O 62

Figure 4-3
Parameter Function
When you see this button, it means pause or not played record. Click on this
Play .
button, switch to normal play status.
Stop Click this button to stop playing.
Click on this button to go to next frame.
Play by Note:
frame _ .
You shall pause record when you use this function.
Slow Click on this button to play slowly.
Quick Click on this button to play quickly.
Silent When this button displays, it means audio is silent. Click on this button to switch
back to normal.
Volume Click on left mouse to adjust volume.
-1 Fisheve Click this button and fisheye device can adjust display mode according to
y different installation mode during the process of playback.
Click the button and it will playback and display intelligent rules and object
- -2 Rule Info detection box if the video is equipped with intelligent rule info after the function is
enabled, it is off by default.

21



4.1.2 Playback File
In calendar, blue date represents data currently has video record or snapshot. See Figure 4-4.

< 2013 S

Sun Mon Tue Wed Thu

Parameter Function
. Select Adavo, as video playback.
File Type - N .
Select Ajpgo as picture playback.
Data Source Default is SD card.

Step 1. Click on data in blue, time axis displays record file progress bar in color. While, green represents
normal record, yellow represents motion detect record, red represents alarm record, and blue
represents manual record.

Step 2. Click on certain time on progress bar, playback starts from this time. See Figure 4-5.

Figure 4-5

Step 3. Click on file list = , select date file will be displayed in list.

Step 4. Double click on file in list, playback this file and display file size, start time and end time.
See Figure 4-6.

22



00 : 00 : 00 - 23 : 59 : 59 jfe¥

General, Event, Alarm, Manual «

Download Format @ dav © mp4

Start Time  File Type
15:49:39 "0
15:50:07
15:54:38
16:25:13
16:31:35
16:32:06
16:45:58
16:54:00
17:00:54

(N eleNelle el Ne

€ €1/1 p pi (]
Begin Time:
End Time:
File Size:

Figure 4-6

Parameter

Function

BSearch

It means records within searched start time and end time on the date.

Record Format

There are two formats: dav, mp4.

mDownload

Click the download button and download file to path in Ch. 5.1.2.5.
System does not support download and playback at the same time.

5
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Parameter Function

€ Back Click on back button to go to calendar interface.

4.1.3 Playback Cut

Note:

Playback cut function will automatically pause playing record as playback cut and playback cannot be at
the same time.

Step 1. Click on start time to cut on time axis. This time must be within progress bar range.

—_—

Step 2. Move mouse to cut icon gﬁ . You will be ask to select start time. Click on cur icon 5‘5 as

finish cutting.

Step 3. Click on playback cut end time on time axis. This time must be within progress bar range.
— —

Step 4. Move mouse to cut icon-& you will be asked to select end time. Click on cut icon ﬁ as
finish cutting.

Step 5. Click on Save button to save file cut to path in Ch 5.1.2.5. See Figure 4-7.

00:00:00-00:00:00 B

Figure 4-7

4.1.4 Record Type

After checking record file type, only selected file will be displayed in progress bar and file list. Users can
also select the record type to be displayed via the dropdown box which is above the file list. See Figure
4-8.

Record Type [ Al [ General [ Motion @ & Alarm & Manual W

Figure 4-8

4.1.5 Progress Bar

24



L (Dadhe | Ozhr ©1hr § O20min

Figure 4-9
Parameter Function
O z4hr o4 hours Click on it, means video in past 24 hours.
®:ztr s hours Click on it, means video in past 2 hours.
O1hr |y hour Click on it, means video in past 1 hour.
(O 30min 30 min Click on it, means video in past 30 min.

4.1.6 Assistant Function
Video playback assistant function is shown in Figure 4-10.

Figure 4-10

Parameter Function

Click on it, video in playback status if is in original size, user can
zoom in any area, If it is not in its original size, right click mouse to
Digital Zoom restore its original size.

Click on this button, you can scroll to zoom in.

E] Click on this button, you can snapshot video under playback status.
Snapshot Snapshot will be saved to path in Ch. 5.1.2.5.

4.2 Picture Playback

Web client picture playback interface has the following three functions:

Parameter Function

1 Play function bar
2 Playback file bar
3 Snapshot type bar

See Figure 4-11.
25



IP cCamera

[>)

Snapshot Type All General W Event M Alarm

4.2.1 Play

e | P | ek [ sews | aam [ _togout ]

Figure 4-11

oo

Figure 4-12

Data Src _SD Card E

< IS >
Sun Mon Tue Wed Thu Fri Sat
123|456 ]|7
8910 11 1213 14
1 [48] [48] [20] [21]
241251262728

31

Default icon is E and it means pause or not played picture. Click on play button to switch to

normal play status. Icon become m

Click on it to pause.
4.2.2 Playback File

26



< 2013 I8

Sun Mon Tue Wed Thu Fri Sat

Figure 4-13

Step 1. Click on file list = , Select snapshot file of the date.

Step 2. Double click on file in list, to play this snapshot.

Parameter

Function

n Search

It means all snapshot files within the start time and end time of selected date.
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Parameter Function
m Click the download button to open snapshot file or directly download to local
Download according to the browser types.
L Back Click on back button to return to calendar interface and re-select time.

00 : 00 : 00 - 23 : 59 : 59 jfe}

Start Time  File Type

13:23:16
13:24:55
13:25:09
13:25:19
13:25:29
13:25:40
13:25:50
13:26:09
13:26:19
13:27:41
13:27:51
13:28:01

M <€1/1p pg

o
o
o
o
o
V)
o

= O
o
o
o
o

|

5

Figure 4-14

4.2.3 Snapshot Type
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After checking snapshot file type, in file list only display file of selected type. Users can also select the
snapshot type to be displayed via the dropdown box above the file list. See Figure 4-.

Snapshot Type All General Event W Alarm

Figure 4-15
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S5 Setup
Web client setup support camera, network, time, storage, system and system info view.
5.1 Camera

The camera setting includes conditions, profile management, zoom and focus.
5.1.1 Conditions
Note:

The camera parameter may be different according to different models, please refer to the actual product

for more details.

5.1.1.1 Picture

Note:

The device which supports true WDR fails to support long exposure when true WDR is enabled.
Step 1

Select ASetup >t iMamser>a P cQourdeido and the system will

shown in Figure 5-1.

IP Camera

Conditions

Profile. Day
> Video

| ¢ 3 i
I\ .f: 4F
> Audio Style | Standard [~]

Network = o ’ - - FERROSe Brightness (=] 0 50
Event —— o » Backlight Contrast (=] O 50
Storage 2
g £ » WB Saturation [=] O 50
System
y! » Day & Night Sharpness [=] O (50
Information ;
» IR Light Gamma [=) O & 50

Mirror ©) ON @ OFF

Flip 0° B

Default I | Refresh 1 l Save

Figure 5-1
Step 2
Set picture parameters; please refer to the following sheet for more details about parameter setting.
Parameter Note
Style It is to set the picture style, which includes standard, soft and vivid.
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Parameter

Note

Brightness

It is to adjust the image overall brightness via linear adjustment mode.
The larger the number is, the brighter the picture is, and on the contrary it

is opposite. The picture get blurry easily when the value is set too big.

Contrast

It is to adjust the picture contrast. The bigger the value is, the bigger the
bright contrast becomes, and on the contrary it is smaller. The dark area
becomes darker and the bright area becomes overexposed easily when
the value is set too big. The picture becomes blurry when the value is set
too small.

Saturation

It is to adjust the color darkness and lightness. The color becomes darker
when the value is bigger; on the contrary it becomes lighter. The value
causes no influence to the overall brightness of the image.

Sharpness

It is to adjust the sharpness level of the picture edge. The bigger the
sharpness value is, the more obvious the image edge becomes, the image
is likely to generate noise more easily when the value is set too big.

Gamma

It is to change image brightness and improve the dynamic display range of
the image via nonlinear adjustment mode. The bigger the value is, the
brighter the picture becomes, and on the contrary it is opposite.

Mirror

After mirror is enabled, the monitoring image will be displayed invertedly.

Flip

It is to change the display direction of the monitoring image.
It includes following options:
Normal: The monitoring picture is normally displayed.

Flip mode 1: The monitoring picture is displayed with clockwise
rotation 90°

Flip mode 2: The monitoring picture is displayed with anticlockwise
rotation 90°

. 180° The monitoring picture is displayed upside down.
Note:

Please set the video resolution as 1080P or lower when applying flip mode
for some devices.

EIS

It can realize electronic anti-flicker function via comparison algorithm of
image difference, which can effectively solve the problem of image jittering
during application and it can make the image clearer.

Step 3

Cl

ck ASavedo and complete the i mage parameter

Y
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5.1.1.2 Exposure
Step 1

Select ASetup > Camera > Conditions > Exposureo. THh
which is shown in Figure 5-2.

IP Camera

Profile | Normal

> Audio ! ERs Anti-ficker | Outdoor

- Sl - E
Network £ e ’ —— m Mode | Auto [~]

Event » Backlight Autolris @ ON OFF
Storage > WB = -
L 3DNR®@ ON () OFF
System » Day & Night
_ : el Grade [=] 0 50
Information » IR Light

Figure 5-2
Step 2
It is to set the exposure parameter, please refer to the following sheet for more details.
Parameter Note

., Outdoor: You can switch to exposure mode when it is in

outdoor mode, it can realize the result in the corresponding
exposure mode.

., 50Hz: When the current is 50Hz, system can auto adjust the
Anti-flicker exposure according to the environment brightness in case
there is any stripe.

., 60Hz: When the current is 60Hz, system can auto adjust the

exposure according to the environment brightness in case
there is any stripe.
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Parameter

Note

Mode

It is the camera exposure mode.
Note:

When #fAntcikero is fAOutdor o,
set as figain priorityod or fis

5

Different devices have different exposure modes; please
refer to the actual interface.

It includes the following options:

Auto: It can auto adjust the image brightness according to
the environment.

Gain priority: The device can auto adjust according to the
gain range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the gain value has reached to upper limit
or lower limit, which is to make the image reach the best
brightness.

Shutter priority: The device can auto adjust according to the
shutter range which is set by priority during normal exposure
range according to the different scene brightness. The device
will auto adjust shutter value if the image brightness fails to
reach the effect and the shutter value has reached to upper
limit or lower limit, which is to make the image reach the best
brightness.

5

Iris priority: Iris value is fixed, the device can auto adjust the
shutter value if the image brightness fails to reach effect and
the shutter value has reached the upper limit or lower limit,
the device can auto adjust the gain value to make the image
reach the best brightness.

Manual: It is to manually set gain value and shutter value,
adjust the the displayed brightness of the image.

Auto Iris

It can set the parameter when the camera installs auto iris.

The lens iris can auto adjust the size according to the
environment after auto iris is enabled, then the image
brightness will change accordingly.

The iris value reaches the max when disabling auto iris, the
lens iris will not change according to the environment
brightness.

5

3D NR

It is to process the image with multiframe (at least two frames), it
can realize noise reduction of the image by using the interframe
information between the previous and latter frame.

Grade

It can set the parameter when
The bigger the grade is, the better NR effect it can realize.
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Step 3
Click ASaveo to complete the parameter config of «caea

5.1.1.3 Backlight

Backlight mode can be divided into BLC, WDR and HLS.

BLC: it can avoid cucoloris phenomenon of the darker area in the backlight environment.

WDR: It can suppress the overbright area and compensate darker area by enabling WDR, which can
make the overall image clear.

HLC: It is to weaken the high light, which can be applied in the areas such as toll gate, entrance and exit
of the parking lot and etc. As for extreme light, it can snapshot the human face in the dark environment
and it can realize better effect for the details of the plate number.

Step 1
Select ASetup > Camera > Condition > Backlighto, th
which is shown in Figure 5-3.

IP Camera

Profile | Normal

> Audio g » Picture Mode | OFF E]
Network == S - — » Exposure

Storage = > » WB

System f » Day & Night

Information » IR Light

=

| Default 1 | Refresh | i Save |

Figure 5-3
Step 2
Set the backlight parameter.
., When thesiNMedeasi afapnat$einfo, attdhadjussthesmtagem wi | |
brightness according to the environmental brightness, which is to make the object display clearly in

the scene.
, When the AModed is set as ABLCO,edimbde.can sel ect de
E When selecting fiDefaultodo mode, the system can

environment, which is to make the image in the darkest area clear to be seen.
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E When selecting ACustomizedd mode, the gaeat em c
after it set customized area, which is to make the image of the selected area reach
appropriate brightness.
R When the AModeo is set as AWDRO, it owi | |l ower t |
enhance the brightness of the area with low brightness, which is to make the objects in both high
brightness and low brightness area display clearly.
Note:
There may be video loss of a few seconds when the camera is switched from non WDR mode to WDR
mode.
, When the AMode o0 i systemevill coastainfihe lhrightness df theearea with high
brightness and decrease the size of the halo area, which is to lower the brightness of the whole
image.
Step 3
Click ASaveo to complete the config of the backligh

5.1.1.4 WB

WB is used to restore the white object in the scene by the camera, after WB mode is set, it can make

the white object look white in different environments.

Step 1

Select ASetup > Camera > Conditions > WBO0, the syst
shown in Figure 5-4.

IP camera

i Zoom and Focus

Profile | Normal [~]

> Audio " L Mode | Auto E
Network = X ! T » Exposure

Event . » Backlight

System » Day & Night

Information

Storage

» IR Light

| Default I I Refresh I l Save |

Figure 5-4
Step 2
Set WB mode.
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When the AModeo is set as fAAutoo, the system can
color temperatures, which is to make the image color normal.

When the AModeo i s set a stocinhpansaterwhite ldalance ththe sseyes t e m
without artificial light, which is to make the image color normal.

. When the fAiModed i s set as ait§dcompersate whitebglancetothdre sy st
outdoor scene at night, which is to make the image color normal.

When the AModeo is set as fAOutdoor o, t lo¢themogtst em
outdoor scenes with natural light and artificial light, which is to make the image color normal.

When the AModeo i s set aathdivislaerofuedlgain,andiblue gaimthe man u a l
system can compensate the different color temperatures in the environment according to the

settings.

When the fAModRegonaiCaustomet it ifAs to set customized ar
compensate white balance to different color temperature of the images in the area, which is to

make the image color normal.

Step 3
Click ASaveo to complete the config of WB mode.

5.1.1.5 Day & Night

It is to set the switch between color mode and black & white mode.

Step 1

Sel ect fSet upCondtidda>nDay&Nightt and t he system wil.| di spl a
Ni ght o, which i$% shown in Figure 5

IP Camera

Profile Normal

[+]

> Video

> Audio BRIl Mode | Auto

Network = IR e —— HEDEEE Sensitiity | Middle

MEIE

-~ o9 _
Event - e » Backlight Delay|6S

Storage » WB

» Day & Night

System

Information

» IR Light

l Default ‘ | Refresh | | Save |

Figure 5-5
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Step 2

Set day & night parameter; please refer to the following sheet for more details.

Parameter

Note

Mode

It is to set the camera image displayed as color or black & white mode.
Note:
The setting of fiDay/ Ni ght Modeo i
Management 0.
It includes the following options:
Color: The camera image is displayed as color image.
Auto: The camera can auto select color image or black & white image
to be displayed according to the environmental brightness.
Black & white: The camera image is displayed as black & white image.

Sensitivity

The parameter can be setwhent he fADay/ Ni ght Mode(
It is to set the sensitivity of the switch between image color display and
black & white display.

Delay

The parameter can be set when the
It is to set the switch delay between image color display and white & black
display. The smaller the delay is, the faster of the switch becomes between

color display and black & white display.

Step 3

Click ASaved to complete the config of day/ ni

5.1.1.6 Defog

The image quality will become weak when the device is in the environment with fog or haze, you can
enable defog function to adjust the image definition.

Step 1
Sel ect

iSetup > Camera > Conditions > Defogo

which is shown in Figure 5-6.

ght

and
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IP Camera

Profile Day
> Video

> Audio ey P Mode OFF [+]
Network = - = S - » Exposure
Event » Backlight

Storage i e » WB

System J » Day & Night

Information

[ pefautt [ Refiesh || Save |

Figure 5-6
Step 2
It is to set defog mode according to the actual scene.
, When the AModeo is set as AManual o, it is to manu

will adjust the image definition according to the intensity and air light mode which have been set
previously. As for air light mode, you can set manual or auto.

, When the AModeodo is set as AAutoodo, the system wil/
actual scene.

, When the fAModedo is set as nAOWlethdo, then the defog f

Step 3

Click ASavedo to complete the config of defog mode.
5.1.1.7 IR Light

You can directly set the mode of IR light if the device is equipped with IR light.

Step 1

Select ASetup > Camera > Conditions > flaR eLiodgh tid Ra n_Lo
which is shown in Figure 5-7.
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IP Camera

| Zoom and Focus

= Profile. Normal =]
Event » Backiht
storage e
System | » Day & Night
Information
[ oemun [ Reresn [[ sae ]
Figure 5-7
Step 2
Itis to set IR light mode according to the actual scene.
, When the AModeo is set as AManual 6, it can manual
realize light compensation to the image according to the IR light intensity.
., When the AModed is set as ASmart | R0, the system
actual scene.
., When the AModeo is set as AZoompriod, theesystem
brightness change of the actual scene.
E The system will enable near light by priority when the actual scene becomes dark, the system
will enable the far light when the near light fails to meet the requirement of scene brightness
even if it is adjusted to the brightest.
E The system will adjust far light brightness by priority to off and then adjust the brightness of
near light when the actual scene becomes bright. The system will always disable far light
when the focal length of the lens is adjusted to a certain wide angle, which is to avoid near
overexposure. Meanwhile, it can manually set light compensation to slightly adjust the
brightness of IR light.
, When the Amoded is set as AOffo, it will not enatb
Step 3
Click fASav e ethacordigotflR Igipt.l e t
5.1.1.8 Profile Management
Step 1
Select ASetup > Camera > Conditions > Profile Manag
AProfile Management 0.
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Step 2
Set profile management.

., When the AProfil e Mbnramalme,nttohd ss ysette m swifl | moni t
config.
IP Camera
Camera Conditions Profile Management] Zoom and Focus
7z Profile Management ¢ Normal ¢ Full Time ¢ Schedule
> Video
> Audio Default | | Refresh I | Save
Network
Event
Storage
System
Information
Figure 5-8
, When the AProfile Managemento is set as AFull Tin
ANi ght o6, tmensyotremcwiolrlding to the config of Aal\

IP Camera

Came Conditions Profile Managementl Zoom and Focus

. Profile Management ¢ Normal  Full Time ¢ Schedule
> Video
Always Enable Day =
> Audio

Network | Default | | Refresh | ] Save

Event
Storage
System

Information

Figure 5-9
When the AProfile Managemento is set as ASchedul e
period as night, for example, if it sets 0:00~12:00 as day, 12:00~24:00 as night, then the system will
monitor by adopting corresponding config in different periods.

B

IP Camera

Camera Conditions Profile Management]  Zoom and Focus

Profile Management (" Normal € Full Time * Schedule
> Video

> Audio

Network Period setting Q D

0:00 4:00 8:00 12:00 16:00 20:00 24:00

Event
Storage [EDay M Night

Systent l Default | i Refresh | |

Information

Figure 5-10
Step 3
Click ASaved to complete the settings of profile ms
Note:
Click nbDefaultdo to restore the device to default coc
device.
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5.1.1.9 Zoom and Focus

Note:

Only motorized vari-focal devices support focus and zoom function.

Step 1

Select ASetup > Camera > Conditions > Zoom and FocU
iZoom and FocusoOo whielh.h i s shown in Figure 5

IP Camera T ST T T TR AT
®

Camera Conditions

Profile Management Zoom and Focus

> Video

> Audio
Network
Event
Storage
System

Information

zoom WDE (=) [ - TELE Speed [20 Restore All
Focus NEAR (=) (0 - FAR  Speed [20 | | D+JAutoFocus Refresh

Figure 5-11
Step 2
Adjust the focal length of the lens.
After it is zoomed, sfear Aidpagedtdohandl ipdiesg Bil+@dc k Adi r
Step 3
Adjust the lens definition.
After it is focused, -f%alagtheSlgiegdldck diractlydo agjuste ss A +06, 0
Note:
., Speed is used to set thei.l ength by pressing A+0 ¢
, After adjusting the focal | ength of the |l ens or
image definition, it is not allowed to implement other lens operation during auto focus.
, Afterseveraltmesofzoom and focus, the image fails to be a

reset the lens to zero and remove the accumulative error of the lens.
, Click ARefresho and t mgchbeize thehardwaie tolthe lacatioroofsiding ¢ a | |y
block of lens zoom and focus.

5.1.2 Video
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5.1.2.1 Video

Step 1

Select ASetup > Camera > Video > Videoo and the sys
shown in Figure 5-12 or Figure 5-13.

IP Camera

C Video Snapshot Overlay Path

> Conditions
Video Main Stream Sub Stream

Network Enable Sub Stream 2 v
Event Encode Mode H.264H v Encode Mode H.264H v
Storage Smart Codec OFF v ® Resolution D1 (704*480) v
System Resolution 2304x1296 (2304*1296 ¥ Video Clip
inforuation Frame rate(FPS) |30 v Frame rate(FPS) |6 v
Bit Rate Type CBR v Bit Rate Type CBR v
Reference BitRate  1792-10240Kb/S Reference BitRate  48-896Kb/S
BitRate 6144 v Bit Rate 896 v
| Frame Interval 60 (30~150) | Frame Interval 12 (6~150)

«| Watermark Settings

Watermark Character | Digital CCTV

Defaut [ Refesn |[_ saw

Figure 5-12 (Non fisheye)

IP camera

Video Snapshot Overlay

Conditions
2 Installation Mode Ceiling E]
Record Mode 2P El
> Audio
Network Main Stream Sub Stream
Event [v] Enable Sub Stream 1 [+]
Storage Code-Stream Type | General [~] Code-Stream Type | General =]
System Encode Mode H.264 E Encode Mode H.264 E]
Information Resolution 2432%2432 (2432*2432)5 Resolution 640x640 (640*640) E]
Frame rate(FPS) |15 [~] Framerale®ES) | 15 [=]
Bit Rate Type CBR EI Bit Rate Type CBR E]
Reference BitRate  2048-11008Kb/S Reference Bit Rate  256-1792Kb/S
Bit Rate 8192 [+] BitRate 1024 [+]
| Frame Interval 30 (15~150) | Frame Interval 30 (15~150)
sve 1(off) [+] SvC 1(off) ]
[V] Watermark Settings
Watermark Character | Digital CCTV
Default | l Refresh | l Save

Figure 5-13 (Fisheye)
Step 2
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Set video bit stream, please refer to the following sheet for more details about the parameters.

Parameter

Function

Installation Mode

It will display the parameter when the device is fisheye.
There are three installation modes for fisheye which are
ceiling, wall mount and ground installation, please
select installation mode according to the actual
installation scene of the fisheye.

The system will begin to switch after switching
installation mode, it will prompt successfully saved after
it is switched successfully.

Note:

The device end will output the dewarped video stream
after configuring installation and record mode, when the
device is accessed to third-party platform, it will directly
display the dewarped image on the third-party platform.

Record Mode

It will display the parameter when the device is fisheye.
The system will begin to switch after record mode is
switched, it will prompt saved successfully after it is
switched successfully.

The record mode will change according to the different
installation modes.

10: the original picture which is not dewarped.

1P: 360fectangular panorama.

2P: The mode can be set
Moded set as fACeilingbo
related 180fectangular ima ge, the two
subwindows can both form 360panorama anytime.
10+3R: original image + 3 independent sub
images, both the sub image and sub boxes in the
original image can support zoom and movement.
1R: Original image + independent sub image, the
sub boxes of the original image support zoom and
movement.

4R: original image + 4 independent sub images,
both the sub image and sub boxes in the original
image support zoom and movement.

2R: Original image + 2 independent sub images,
the sub boxes of the original image can support
zoom and movement, the sub image supports up
and down movement, which can change the
vertical angle of view.

Note:

The device end will output dewarped video stream after
configuring installation and record mode, when the
device is accessed to the third-party platform, it will
directly display the dewarped image on the third-party
platform.

5

B

5
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Parameter

Function

Sub Stream Enable

Sel ect NAEnabled to enabl e
The device supports enabling sub stream 1 and sub
stream 2 at the same time.

Smart Codec

It can enhance image compression performance and
reduce storage space by enabling intelligent encoding.
Note:

After intelligent encoding is enabled, the device will not
support third stream, ROI or intelligent event detection,
please refer to the actual interface for more details.

Code-Stream Type

ACF means using different fps to record.

There are two options: VBR and CBR.

Please note you can set video quality in VBR mode.
Note:

WEB interfaces dondt suppd
code stream setting.

Encode mode

There are five options: H.264 (main profile standard,
H.264H (high profile standard), H.264B (Baseline
Profile), H.265 (main profile standard) and MJPEG
encode.

The H.264, H.264H both are H264 bit stream.
H.264 is the Main Profile encode and you need to
enable the sub stream function in your camera and
set the resolution as CIF. Then you can monitor via
the Blackberry cell phone.

The H.265 is the main profile encode mode.
MJPEG: In this encode mode, the video needs to
large bit stream to guarantee the video definition.
You can use the max bit stream value in the
recommend bit to get the better video output effect.

B

Resolution

There are multiple resolutions. You can select from the
dropdown list.

For each resolution, the recommended bit stream value
is different.

Note: When video is under rotating status, you cannot
set resolution higher than 1080P (excluding 1080P).

Video Clip

The function is only supported by sub stream 2, please
refer to AVideo Clipo for

Frame Rate (FPS)

PAL: 1" 25f/s" 1-50f/s NTSC: 1" 30f/s or 1~60f/s.
The frame rate may vary due to different resolutions.

Bit Rate Type

There are two options: VBR and CBR.
Please note, you can set video quality in VBR mode.
Under MJPEG mode, only CBR is available.

Recommended Bit

Recommended bit rate value according to the resolution
and frame rate you have set.
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Parameter Function

Bit Rate s In CBR, the bit rate here is the max value. In
dynamic video, system needs to low frame rate or
video quality to guarantee the value.

The value is null in VBR mode.

Please refer to recommend bit rate for the detailed
information.

svC Frame rate can be encoded by layer. It is a flexible
encoding method. By default, itis 1 as 1 layer. You also
can set 2/3/4 layers.

| Frame Here you can set the P frame amount between two |
frames. The value ranges from 1 to 150. Default value
is 50.

Recommended value is frame rate *2.

Watermark Settings Sel ect AWatermark Setti ngoqd
function. After the watermark function is enabled, you
can check if the video is tampered via verifying
watermark character.

Watermark Character It is the character of watermark verification, it is
DigitalCCTV by default.

., Video Clip
1. Select ASub Stredamn2bdboxn Ich@&.chkr diEknab

2 Enable avid® clipo, click

The system will di splay the interlfdace of HAAread, wt
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Resolution

D1 (704%480)

=]

Save

Cancel

Figure 5-14

Select the needed resolution and clip the needed image on the interface, which is shown in Figure

5-15.

Cl i ck ASa v ehéckthexlipped ddamin the preview interface (the sub stream 2 preview
interface only displays the clipped area), which is shown in Figure 5-15.
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IP camera

Figure 5-15

Step 3
Click ASaved to complete v

5.1.2.2 Snapshot
The snapshot interface is shown as in Figure 5-16.

IP Camera

Video Snapshot
> Conditions

> Audio

Snapshot Type \;Géngrg[
Image Size 1080P (1920%1080)

Quality |5
Network

Interval [1s v
Event

Storage [ oeaut ][ Reesn |[  sae

System

Figure 5-16

Please refer to the following sheet for detailed information.

deo

stream

setup.
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Parameter Function

Snapshot type There are two modes: general (schedule) and Event (activation).
Image size It is the same as the resolution of main stream.

Quality It is to set the image quality. There are six levels.

Interval It is to set snapshot frequency. Optionall~7s/picture, customized.

5.1.2.3 Video Overlay

The video overlay interface is shown as in Figure 5-17.

IP Camera

> Conditions

> Audio

Network
Event
Storage
System

Information

DREUANEEN] (O Enable © Disable

» Channel Title
» Time Title

» Text Overlay
» Picture Overlay
» Counting

I Remove All || Delete

‘ (Or Rightclick )

| Defauit

| | Refresh ‘ | Save |

Figure 5-17
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IP Camera

> Conditions

> Audio
Network
Event
Storage
System

Information

IP Camera

> Conditions

> Audio

Network
Event
Storage
System

Information

» Time Title
» Text Overlay
» Picture Overlay

» Counting

» Privacy Masking @ Enable () Disable

IPC

Snapshot

» Privacy Masking
» Channel Title

» Text Overlay

» Picture Overlay
» Counting

Defautt || Remesn || save |

® Enable Disable

‘Week Display

Figure 5-19
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IP Camera

» Privacy Masking (O Enable © Disable

> A T » Channel Title Input Text:
o ’
Network —— » Time Title
letworl I
Event ' .
Storage 2 3 » Picture Overlay
System » Counting
Information
Text Align
Right

IP Camera

> Conditions

» Privacy Masking () Enable @ Disable

» Channel Title Picture Preview:
> Audio
Network » Time Title
e 5
s 5 - . - e » Text Overlay
storage ; - DisiEoa |
System » Counting
Information
Upload Picture
Requirement for picture upload
1. Max size is 16k.

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.

Figure 5-21
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IP Camera

Snapshot

| » Privacy Masking (O Enable @ Disable
~ » Channel Title Statistics Type

&

S » Time Title [¥] Enter Number

» Text Overiay [v] Leave Number

= » Picture Overlay = TextAlign

2

Storage

System

Information

Defauit | | Refresh | | Save

Figure 5-22

Please refer to the following sheet for detailed information.

Parameter Function

Here you can privacy mask the specified video in the
monitor video.
System max supports 4 privacy mask zones.

Privacy Masking | -

Time Title . You can enable this function so that system overlays time
information in video window.
You can use the mouse to drag the time tile position.

Channel Title . You can enable this function so that system overlays
channel information in video window.
You can use the mouse to drag the channel tile position.

You can enable this function to overlay text in video
window.

You can use the mouse to drag location box to adjust its
position. Alignment include align left and align right.

Text Overlay s

You can enable this function to display overlay picture.
Click on disable to turn it off.

Click on Upload Picture to overlay local picture into
monitoring window. You can drag the yellow box to move
it.

Picture Overlay | -

Note:
You cannot enable text and picture overlay at the same time.
Counting ., Check 0 BEriapky teecounting statistics data in
the video monitoring windoW
display.

There are enter number and leave number for statistics

type and left align and right align for OSD info.
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Refresh s Set privacy mask, channel title, time title, location, overlay
and save the change. You can click on Refresh to see
effect.

Default . Click it to restore default config.

Save . Click it to complete video settings.

5.1.2.4 ROI
Not e: Some series dondt support ROI

IP Camera

Camera

> Conditions
> Audio

Network

Event

Storage

System

Information

Snapshot

setup

Enable (¢ Disable

Image Quality | 6(best) v

[ Remowean [[  Delete

| tor Righteick )

| Default | \ Refresh

‘ | Save

IP Camera

Camera

> Conditions
Video

> Audio

Network

Event

Storage

System

Information

Remove All Delete (Or Rightclick )

Figure 5-23

Enable (® Disable

Image Quality | 6(best) v

[ peraur [ Refresn

I

Save

funct
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Figure 5-24

Parameters | Note

Check i
Enable o
Check i

Enabl ed, then it wil bringwindogwj ay t h
Di sableo, then it wondét display.

Set the image quality of ROI, ranging from 1" 6, default is 6.

Image Note:
Quality For fisheye device, it ranges from 1~6 (best), default is 6 (best)

Able to set area block, max 4 areas.

5.1.2.5 Path

The storage path interface is shown as in Figure 5-25.

Here you can set snap image saved path and the record storage path.

The default monitor image path is C:\Users\admin\WebDownload\LiveSnapshot.

The default monitor record path is C:\Users\admin\WebDownload\LiveRecord.

The default playback snapshot path is C:\Users\admin\WebDownload\PlaybackSnapshot.

B

The default playback download path is C:\Users\admin\WebDownload\PlaybackRecord.
The default playback cut path is: C:\Users\admin\WebDownload\VideoClips.

Note:

Admin is locally logged in PC account.

Please click the Save button to save current setup.

IP camera L we | ez | eaymec [ sewp | mam [ Logot

Camera Video

Snapshot

Conditions
2 Live Snapshot C:\Users\admin\WebDownload\LiveSnapshot Browise...
. - Live Record C:\Users\admin\WebDownload\LiveRecord Browse...
> Audio
Playback Snapshot  C:\Users\admin\WebDownload\PlaybackSnapshot Browse...
Network
Evenit Playback Download  C:\Users\admin\WebDownload\PlaybackRecord Browse...
ven
Video Clips C:\Users\admin\WebDownload\VideoClips Browse...
Storage
System Default I | Save
Information

Figure 5-25
5.1.3 Audio
Please note some series devices do not support audio function.
5.1.3.1 Audio

The audio interface is shown as below. See Figure 5-26.
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IP Camera

Camera

> Conditions
> Video
Network
Event
Storage
System

Information

Audio

[~ Encode

Main Stream
[V] Enable
Encode Mode GT711A E]
Sampling Frequency | 16k E'
Sub Stream
[C] Enable Sub Stream 1 E[
Encode Mode GT711A E]
Sampling Frequency | 16k El
[~ Attribute
Audioln Type Lineln [~]
Noise Filter Enable E
Microphone Volume (=] 0 50
SpeakerVolume  [=] 0 50

Default | [ Refresh | | Save

Figure 5-26
Please refer to the following sheet for detailed information.
Parameter Function
Enable You can enable audio only when video is enabled.

After selecting the fAEnabl eod
network transmission stream is the audio/video composite
stream, otherwise it only includes video image.

Encode mode

The encode mode of the main stream and extra stream include
G.711A, G.711Mu, G.726 and ACC. The default mode is
G.711A.

The setup here is for audio encode mode and the bidirectional
talk encode both.

Sampling
Frequency

The sampling frequency of audio. It includes the following
options:

8K

16K
32K
48K
64K

5

5

5
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Audioln Type Two modes to select: Lineln, Mic. Device needs to connect
external audi o input source u
need to connect external audio input source under Mic mode.

Noise Filter Enable the function and it can filter relevant noise.
Microphone Adjust microphone volume from 0" 100.
Volume Note:

Supported by some devices.

Speaker Volume | aqi st speaker volume from 0" 100.

Note:
Supported by some devices.

5.1.3.2 Alarm audio

IP Camera

Alarm Audio

> Conditions

> Video

Network

@ alarm1.pcm

@ alarm2.pcm

Event
Storage
System

Information

Figure 5-27
Add Audio File B3
= Record = Upload
Audio File | pcm
Record
Figure 5-28

Audio management currently supports PCM format to record and PCM, wav two forms to upload’
and can select an audio file for the audio alarm linkage.
The way to download the web alarm playback audio file into local is as follows:
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Step 1 Use the left mouse button to click the hollow circle “in the fAchoiced col

and shows @- which means effective choice of alarm audio.

Step 2 Use the right mouse button to click L. select Asave target aso t
5.2 Network
5.2.1 TCP/IP

The TCP/IP interface is shown as in Figure 5-29. It supports IPv4 and IPv6. IPv4 supports static IP and
DHCP. IPv6 supports static IP only. When users manually modify IP address, WEB will automatically
jump to the new IP address.

IP Camera

Camera TCPIIP
N
> Connection Ethemet Card Wire(DEFAULT) [+]
> PPPoE Mode © Satic ) DHCP

Host Name

IPC

> DDNS MAC Address

> IP Fiter 1P Veersion 1Pv4 [=]
> SMTP(Email)

> Multicast

IP Address 0 . 15 . 1 . 171
BLEF Subnet mask 255 .255. 0 . 0
> SNMP
Default Gateway 0 .15 . 0 . 1
> Bonjour
Prefered DNSServery 8 . 8 . § . 8
4

3 8021x Altemate DNS Server| 8 . 8 . 4 .

> QoS Enable ARP/Ping to set IP address service
05

Event Default ‘ ‘ Refresh | | Save
Storage

System

Information

Figure 5-29
Please refer to the following sheet for detailed information.
Parameter Function
Host Name It is to set current host device name. It max supports 15
characters.
Ethernet Card Please select the Ethernet port. Default is wired.

Please note you can modify the default Ethernet card if there is
more than one card.

Mode There are two modes: static mode and the DHCP mode. Select
DHCP mode, it auto searches IP, and you cannot set IP/subnet
mask/gateway. Select static mode, you must manually set
IP/subnet mask/gateway.

Mac Address It is to display hose Mac address.
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IP Version It is to select IP version. IPV4 or IPV6.
You can access the IP address of these two versions.
IP Address Please use the keyboard to input the corresponding number to

modify the IP address and then set the corresponding subnet
mask and the default gateway.

Preferred DNS

DNS IP address.

Alternate DNS

Alternate DNS IP address.

Enable
ARP/Ping set
device IP

address service.

You can use ARP/Ping command to modify or set the device IP
address if you know the device MAC address.

Before the operation, please make sure the network camera
and the PC in the same LAN. This function is on by default.

You can refer to the steps listed below.

Step 1: Get an IP address. Set the network camera and the PC
in the same LAN.

Step 2: Get the physical address from the label of the network
camera.

Step 3: Go to the Run interface and then input the following
commands.

arp s <IP Address> <MAC>
ping il 480 it <IP Address>
Suchas arp -s 192.168.0.125 11-40-8c-18-10-11
ping -I 480 -t 192.168.0.125
Step 4: Reboot the device.

Step 5: You can see the setup is OK if you can see there are

the command output lines. Now you can close the command
line.

Step 6: Open the browse and then input http://<IP address>.
Click the Enter button, you can access now.

out put information such as AR

5.2.1.1 P2P

Click fAEnabl
clientofP2Paf t er

ed to connect the device to networ k, an

AOnl ineod is displayed on the i

scan QR code). See Figure 5-30.

nterface
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IP PTZ Dome

ICIPPIIN0YL 1506NEATD0002

PTZ Settings.
Event
Storage
System
Information

Figure 5-30

5.2.2 Connection

5.2.2.1 Connection

The connection interface is shown as in Figure 5-31.

IP camera

Camera Connection

S Max Connection 10 (1~20)
Connediion TCP Port 37777 (1025~65534)
o UDP Port 37778 (1025~65534)
> DDNS HTTP Port 80
> IPFilter RTSP Port 554
> SMTP(Email) HTTPs Port 443

> UPnP

> SNMP
> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs

Event

Storage

System

Information

peraut ||

Figure 5-31
Please refer to the following sheet for detailed information.
Parameter | Function
Max It is the max Web connection for the same device. The value ranges from 1
connection | to 20. Default connection amount is 10.
TCP port Port range is 1025~65534. The default value is 37777. You can input the
actual port number if necessary.
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UDP port

Port range is 1025~65534. The default value is 37778. You can input the
actual port number if necessary.

HTTP port

Port range is 1025~65524. The default value is 80. You can input the
actual port number if necessary.

RTSP port

The default value is 554. Please leave blank if use default. User uses
QuickTime or VLC can play the following formats. BlackBerry can play
too.

Real-time monitoring URL format, please require real-time RTSP
media server, require channel no., bit stream type in URL. You may
need username and password.

User uses BlackBerry need to set encode mode to H.264B, resolution
to CIF and turn off audio.

URL format is:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP and port.

The IP is device IP and the port default value is 554. You can leave it in
blank if it is the default value.

Follow standard RTP protocol and when encode mode is MJPEG, the max
resolution only supports 2040*2040.

B

HTTPs
Port

HTTPs communication port, range is 1025~65534, default is 443.

Note:

0" 1024, 37780 37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 are all special ports.
User cannot modify them.
Avoid using default port value of other ports.

5.2.2.2 ONVIF

ONVIF Open Network Video Interface Forum™ ~ this standard describes network video mode,

interface, data type and data interaction mode. ONVIFSt andar d6s ai mnetwsrkvideo ac hi ev
frame agreement and makes the network video products (including video front-end, video equipment,

etc.) from different manufacturers completely compatible.
ONVIF function is on by default.
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IP Camera

Camera Connection ONVIF

> TCPIP Authentication @ ON (©) OFF

Default ‘ | Refresh | l

> PPPOE

Save

> DDNS
> IP Filter
> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS

> HTTPs
Event
Storage

System

Figure 5-32

5.2.3 PPPoOE
The PPPoOE interface is shown as in Figure 5-33.
Enter the PPPoE username and password which are provided by ISP (Internet Service Provider), and

click AEnabl ed. The net wastabkish cetworlecormection ih the modetofo mat i c al
PPPoE after it is enabled, after it is successful,
into the dynamic IP address of the acquired WAN.

Note:

After PPPoOE dial-up is successful, it needs to log in the device via the IP which is set before dial-up; in

the PPPOE setup interface, it will display the registered IP address, and then it can visit the IP address
via client.

Please disable UPnP when clicking PPPoE enable, which is to avoid causing influence to PPPoE dial-
up.

IP Camera

Camera PPPoE
Network [ Enable

> TCPIP
Usemame
> Connection

Password
> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS
Event

Storage

System

Information
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Figure 5-33

5.2.4 DDNS

The DDNS interface is shown as in Figure 5-34.

The DDNS is to set to connect the various servers so that you can access the system via the server.
Please go to the corresponding service website to apply a domain name and then access the system
via the domain. It works even your IP address has changed. When the device connects to WLAN, you

should disable UPnP.

IP Camera

Camera DDNS
Network

> TCRIP

[CIserver Type ICDDNS

Server Address
> Connection

Mode ® Auto Manual
> PPPOE

> IP Fitter

Domain Name: .icddns.com

Username (Optional)Please input the mailbox

> SMTP(Email) Default ‘ | Refresh | | Save

> UPnP

> SHMP

Storage

System

Information

Figure 5-34

Please refer to the following sheet for detailed information.

Parameter Function

Server Type Click it to select DDNS protocol type, which includes: ICDDNS,
NO-IP DDNS, Dyndns DDNS, the default is ICDDNS.

Server Address | DDNS server IP address

ICDDNS

Server address: www. icddns.com
NO-IP DDNS

Server address: dynupdate.no-ip.com
Dyndns DDNS

Server address: members.dyndns.org

Mode Default is auto, it can select manual

DomainName [Bot h aut o and manuaicd darse. didieC
default, it is able to set prefix manually.
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Parameter

Function

Username

The user name you input to log in the server, optional.

The ICDDNS interface is shown as in Figure 5-35.

IP Camera

Camera
Network
O

> TCPIP

> IPFitter

> SWTP(Email)

> SHMP
> Honjour
> Mutticast

> Wil

Event

Storage

System

Information

DDNS
Server Typs [icoons ____Jg
Server Address
Mode

9 Auto Manual

Domain Name icddns.com

Usemame (Optional)Please input the mailbox

Default Refresh Save

Figure 5-35
Parameter Function
Server Type You can select ICDDNS protocol
Server Address | Under ICDDNS the default server address is Aiwww.icddns.como
Mode Default is auto, manual is optional.

Domain Name

The default is IMAC address.icddns.comofor both auto and manual, for manual
users can set prefix by themselves.

Test It is to test if the domain name can be used or not. The parameter exists only when
selecting fmanualdin iModea
Username The user name you input to log in the server, optional.
5.2.5 1P filter

The IP filter interface is shown as in Figure 5-36.

You can enable IP filter function so that some specified IP/MAC user can access the network camera.
You can add IP address or IP segment.

If you do not check the box here, it means there is on access limit.
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Here you can add IP address and MAC address. You must add these addresses before enabling the

trusted sites.

Please note: You must set MAC address in the same network segment.

IP camera

Camera

> TCPiIP

> Connection
> PPPoE

> DDNS

> SMTP(Email)
> UPnP

> SNMP

> Bonjour
> Muliicast
> 802.1x
> QoS
Event

Storage

System

Information

IP Filter

Trusted Sites
Trusted Sites

IP address IMAC address

Modify

Delete

5.2.6 SMTP”~ e-mail)

The SMTP interface is shown

IP camera

Camera

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter
SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage

System

Information

SMTP(Email)

SMTP Server
Port

[ Anonymity
Usemame
Password

Sender

Authentication
Title

Mail Receiver

Interval

[7] Health Mail

Figure 5-36

as in Figure 5-37.

none

25

anonymity
ene

none

None [+]

IPC Message Attachment

S

0 Second (0~3600)
Update Period

| oefamn || Refesn || sawe

Second (1~3600)

Figure 5-37

Please refer to the following sheet for detailed information.
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Parameter

Function

SMTP Server

Input server address and then enable this function.

Port Default value is 25. You can modify it if necessary.

Anonymity For the server which supports the anonymity email function, it
wonoét display the informatio

User Name The user name of the sender email account.

Password The password of sender email account.

Sender Sender email address.

Authentication You can select SSL, TLS or none.

(Encryption

mode)

Title (Subject)

Input email subject here.

System can send out the email of the snapshot picture once

Attachment
you check the box here.

Mail receiver Input receiver email address here. Max three addresses.

Interval The send interval ranges from 0 to 3600 seconds. 0 means
there is no interval.
Please note system will not send out the email immediately
when the alarm occurs. When the alarm, motion detection or
the abnormity event activates the email, system sends out the
email according to the interval you specified here. This
function is very useful when there are too many emails
activated by the abnormity events, which may result in heavy
load for the email server.

Health mail Please check the box here to enable this function.

enable

Email test The system will automatically sent out a email once to test the
connection is OK or not .Before the email test, please save
the email setup information.

5.2.7 UPnP

It allows you to establish the mapping relationship between the LAN and the public network.
Here you can also add, modify or remove UPnP item. For UPnP on different routers, you must disable
UPNP function. See Figure 5-38.

In the Windows OS, From Start->Control Panel-> Add or
WindowsComponeamtds @ hen select the
Click the Details button and then
AUPNP User I nterfaceo. Pl emse click OK to

remove programs. Cliclk
ANet work Serviceso f
check the d@dnterr
begin ins
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Enable UPnP from the Web. If your UPnP is enabled in the Windows OS, the network camera can auto
detect it via the AMy Network Pl aceso

Under manual mode, you can modify external port. Under auto mode, select idle port for auto port
mapping without user modification.

IP Camera

Camera UPnP

[] Enable Mode | Manual |Z| Router State Mapping Failed
> TCPIP

Port Mapping List

> Connection

Internal Port

> PPPoE WebService WebService TCP 30 8080 Mapping Failed V. -
> DDNS PrivService PrivService:-TCP 37777 3rrer Mapping Failed
> IP Filter PrivService PrivSenvice:UDP 37778 3r7re Mapping Failed
> SMTP(Email) RTSPService RTSPService: TCP 554 554 Mapping Failed

> SNMP

> Bonjour

» Multicast

» B02.1x

> QoS

Event

Storage

System

Information

Figure 5-38

5.2.8 SNMP

The SNMP interface is shown as in Figure 5-39 and Figure 5-40.

The SNMP allows the communication between the network management work station software and the
proxy of the managed device. Please install the software such as MG MibBrowser 8.0c software or
establish the SNMP service before you use this function. You need to reboot the device to activate the
new setup.
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IP camera

Camera SNMP

Network

SNMP Version
> TCPIP

> Connection SNMP Port

> PPPoE Read Community
> DDNS Write Community
> IP Filter Trap Address

> SMTP(Email) —

> UPnP

SNMP

> Bonjour

> Multicast
> 802.1x
> QoS

Event

Storage

System

Information

[] SNMP w1 [T] SNMPv2 [7] SNMP v3

161 (1~65535)
public

private

162

Defaut || Refesh || Save

Figure 5-39

Please refer to the following sheet for detailed information.

Parameter

Function

SNMP Version

Check SNMP v1, device only process vl info.
Check SNMP v2, device only process V2 info.

Check SNMP v3, can set username, password and
encryption method. Server calibrate corresponding
username, password and encryption method too access
device and v1/v2 are unavailable.

SNMP port

The listening port of the proxy program of the device. Itis a
UDP port not a TCP port. The value ranges from 1 to 65535.
The default value is 161

Community

It is a string, as command between management and proxy, ,
defining a proxy, and a man

Read community

Read-only access to all SNMP targets, default is public.
Note: Only number, letter, , and i supported.

Write community

Read/write access to all SNMP targets, default is private.
Note: Only number, letter, , and i supported.

Trap address

The destination address of the Trap information from the
proxy program of the device.

SNMP trap is a proxy message sent to admin as important

Trap .
event notice or status change.
Trap Address Address where to send Trap message.
Trap Port Port which send Trap message, default is 162, range

1~65535.
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IP camera

Camera
Network

> TCPIP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

> Multicast
> 802.1x

> QoS
Event
Storage

System

Information

SNMP

SNMP Version SNMP v1 SNMP v2 SNMP v3
SNMP Port 161 (1~65535)
Read Community public

Write Community private

Trap Address

Trap Port 162

Read-only Usermame public

Authentication Type @ MD5 (O SHA

Authentication Password

Encryption Type @ CBC-DES
Encryption Password

Read&write Userame private
Authentication Type @ MD5 @ SHA

Authentication Password
Encryption Type @ CBC-DES

Encryption Password

Default | | Refresh ‘ ‘ Save

Figure 5-40

Check SNMP v3 version and SNMP port, read community, write community, Trap address, Trap port
are same with SNMP v1 and SNMP v2 versions. Only when SNMP version is SNMP v3, users need to
configure parameter in chart.

Parameter Function
SNMP Version | SNMP v3
Read-only Defa_ult is public.
Username Note:
Name only can be number, letter and underline.
Read/Write BE::-UH is private.
Username Name only can be number, letter and underline.
Authentication | You may select MD5 or SHA, default is MD5.
Authentication Password not less than 8 characters.
Password
Encryption Default is CBC-DES.
Encryption Password not less than 8 characters.
Password
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5.2.9 Bonjour

The Bonjour interface is shown as below. See Figure 5-41.

Bonjour is based on the multicast DNS service from the Apple. The Bonjour device can automatically
broadcast its service information and listen to the service information from other device.

You can use the browse of the Bonjour service in the same LAN to search the network camera device
and then access if you do not know the network camera information such as IP address.

You can view the server name when the network camera is detected by the Bonjour. Please note the
safari browse support this function. Click the fDisplay All Bookmarks: and open the Bonjour, system can
auto detect the network camera of the Bonjour function in the LAN.

IP camera

Camera Em

Network Enable

> TCP/IP

> Connection

> PPPoE —
> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

Server Name YZC4EZ008WO00019

Bonjour
> Multicast
» 8021x
> QoS

Event

Storage

System

Information

Figure 5-41

5.2.10 Multicast

The multicast interface is shown as in Figure 5-42.

Multicast is a transmission mode of data packet. When there is multiple-host to receive the same data

packet, multiple-cast is the best option to reduce the broad width and the CPU load. The source host

can just send out one data to transit. This function also depends on the relationship of the group

member and group of the outer.

Note:

. Open preview, streaming media protocol, select multicast, and monitor via multicast format.

. Here you can set multicast address and port. You also need to go to Live interface to set the
protocol as Multicast.

68



IP Camera

Camera

Network

> TCPIIP
> Connection
> PPPoE
> DDNS
> IP Filter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
[ tuicsst___]
> 802.1x
> QoS

Event

Storage

System
Information

Main Stream

Multicast

Sub Stream

Enable Enable Sub Stream 1 (=]
Multicast Address 224 1 2 . 4 |(22400.0~239255 255 255) Multicast Address 224 1 2 4 | (224.0.0.0~239.255.255.255)
Port 40000 (1025~65534) Port 40002 (1025~65534)

Figure 5-42

Please refer to the following sheet for detailed information.

Parameter

Function

Enable

Select to enable multicast function. Main stream and sub stream cannot be
used at the same time.

Multicast address

Main/sub stream multicast default address is 224.1.2.4 and its range is
224.0.0.0° 239.255.255.255.

Port

Multicast port. Main stream is 40000, sub streaml is 40016,sub stream?2 is
40032 and the range is 1025 65534.

5.2.114G

Note: This function is only for series with 4G module.

4G is a mobile communication system which makes wireless communication integrates with Internet

and multimedia communication.

5.2.11.1 Dialing Setting
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IP Camera

Camera

> Connection
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

> Multicast

> QoS

Event
Storage
System

Information

Dialing Setting | Mobile Settings

Wireless Net Type Auto B [¥] Enable
APN 3gnet
Authorize Mode No [+]
Dial-up Number *99%
Usemame
Password
Update Period 30 Second
Time Range
Wireless Network State
IP Address
Wireless Signal WCDMA 0%
FDD-LTE — 70%
pefaut|[ Reesn ][ sae
Figure 4-53
Parameter Function

Wireless Net Type

Auto, WCDMA, FDD-LTE optional, you can select according
to the operator.

Enable

Check to enable 4G module.

APN

It shall be acquired from the operator according to the setup
of operator.

Authentication Mode

Auto, PAP and CHAP, the authentication algorithm is
different according to different operators.

Dial-up Number

The number is different according to different operator, it can
be acquired from operator.

User name

It shall be acquired from the operator.

Password

It shall be acquired from the operator.

Update Period

It is the period beyond the dial-up period which has been
set, it is 30s by default, which means the device can auto
acquire 4G dial-up status, cut off dial-up to save flow.

Time Range It is the time period to set dial-up. It can activate the function
via message to enable/disable dial-up function if it is
beyond the time period.

IP Address It will display the acquired IP after the dial-up is successful

via 4G.
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5.2.11.2 Mobile Setting

IP Camera

Camera Dialing Sefting | Mobile Settings

Network
etwork

[T] Message Send [7] Message Activation [] Phone Activation

> TCPIP

Receiver Sender + Caller +

> Connection
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> Bonjour

> Multicast

> Qos

Event

Title Event Message

Storage

System

Default | | Refresh ! ‘ Save

Information

Figure 4-54

Please refer to the following sheet for detailed information.

Parameter Function

In the event, after the corresponding message activation is
enabled, it will send message to the phone of receiver when
event happens. It needs to enable the function of message
activation function in the event interface when using the

Message Send

function.
Message It can send message ON/OFF to the SIM card inside the device by
Activation the mobile phone in the list, which is to enable /disable the dial-up

function and send REBOOT to restart the device.

You can use the mobile phone in the calling list to call the SIM card
inside the device to enable dial-up function.

Phone Activation

5.2.12 WIFI

Note:

Some series devices don6ét support W FI and WPS func
WPS function is supported by the devices with WPS button.

5.2.12.1 WIFI

WI F I info can show the name, status, I P informati on

WIFI work information after reconnection to ensure the real-time display of the work status, because it
often takes some time to connect WIFI Hot Spot, which depends on the network signal strength.
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IP Camera

Camera

> TCPAP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast
I

> 802.1x

> QoS

Event

Storage

System

Information

WIFI

I” Enable \ Add SSID H Search 8SID |

1D List

Signal Quality

WIFIINFO
Current Hot Spot
IP address
Subnetmask
Default Gateway

Figure 5-45

WIFI setting method is as follows:

Step 1

™ Enable

Click

Step 2
Cli

ck i

¥ Enable

, show as means enabling WIFI function.

S e and shdws tBeSnhirdless,network hot spot of the current network camera

environment in the list.

IP Camera

Camera

> TCPAP

> Connection
> PPPoE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage

System

Information

WIFI

¥ Enable Add SSID ” Search SSID |

5370test WPAMWPA2-PSK-TKIP+AES

TP-LINK_465EF6 WPA-PSK-TKIP+AES
AndroidAP WPA2-PSK-AES
TP-LINK_425796 PA2-PSK-TKIP+AES
NETGEARS4 NONE

TP-LINK_NIJIAN WP A2-PSK-TKIP+AES

WIFIINFO
Current Hot Spot
IP address

unconnected

Subnetmask
Default Gateway

Figure 5-46
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Step 3

Click i Ad dl [»déhen need to add a wireless network manually’ pop out an interface in the figure
below, and enter network ID in the dialog box.

Add Wireless SSID X

SSID

Ok Cancel

Figure 5-47
Step 4 Double click on one can pop out the signal intensity and authentication of the hot spot.

¥ Please enter the password if necessary. Please keep the choice of password index
number same as the router when entering password.

¥ Please click Aconnecto if it is unnecessary toc

5.2.12.2 WPS

IP Camera

Camera WIFI

 Enter PIN
> TCPAP
PIN:
> Connection
SSID
> PPPoE

> DDNS
> IP Filter

 Button

Status disconnected

> SMTP(Email) Connecting | l Refresh

> UPnP

> SNMP

> Bonjour

> Multicast
WIFL

> 802.1x

> QoS

Event

Storage

System

Information
Figure 5-48
PINNumber and SSI D are both acquired from the router
to ensure the real-time display of work state after filling in correctly.

5.2.13802.1x

802.1x (port based network access control protocol) supports manual selection of authentication
method to control if device connected to LAN can join the LAN. It well supports authentication, charging,
safety and management requirement of network.
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IP Camera

Camera 802.1x
Network

> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

[C] Enable
Authentication
Usemame

Password

> Bonjour
> Multicast
> QoS
Event
Storage
System

Information

Figure 5-49

Please refer to the following sheet for detailed information.

Parameter Function

Authentication | PEAP (protected EAP protocol).

Username It needs the username to login, which is authenticated by the
server.
Password Please input password here.
5.2.14 QoS

The QoS interface is shown as below. See Figure 5-50.

Qos (Quality of Service) is network security mechanism. It is a technology to fix the network delay and
jam problem and etc. For the network service, the quality of service includes the transmission bandwidth,
delay, the packet loss and etc. We can guarantee the transmission bandwidth, lower the delay, and
reduce the loss of the data packet and anti-dither to enhance the quality.

We can set the DSCP (Differentiated Services Code Point) of the IP to distinguish the data packet so
that the router or the hub can provide different services for various data packets. It can select the
different queues according to the priority (64 different priority levels) of the packets and select the
bandwidth of the each queue. Level 0 is the lowest, and level 63 is the highest. It can also discard at the
different ratio when the broad bandwidth is jam.

74



IP camera

Camera QoS
Retwos Realtime Monitor
> TCPIP

> Connection

> PPPoE

> DDNS

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

Command

> Bonjour
> Multicast
> 802.1x
[ cos
Event
Storage
System

Information

0
0

Figure 5-50
Please refer to the following sheet for detailed information.
Parameter Function
Real-time The value ranges from 0 to 63. The router or the switcher can
monitor provide different service for various data packets.
Command The value ranges from 0 to 63. The router or the switcher can
provide different service for various data packets.
Enable Check it to enable QoS.
Wireless QoS
5.2.15HTTPs

In the HTTPs setting interface, users can make PC log in normally via HTTPs by creating certificate or
uploading signed certificate, which is to guarantee the security of communication data and provide

safeguard for user information and device security with reliable and stable technical means.

Step 1

Create certificate or upload the signed certificate.

B

Pl ease refer to the following steps if

1. Sel ect ASet upTTPNe,t womrk t>hed system wi ||

shown in Figure 5-51.

you sel
di spl ay
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IP Camera

Camera
>TCF‘/IP [] Enable HTTPs
> Connection Create Certificate
> DDNS Request Created
> IP Filter
; Request Created | || || Download
> SMTP(Email)
Install Signed Certificate
> UPnP
> SNMP Certificate Path Browse...
> Bonjour Certificate Key Path Browse... I |
> Multicast Certificate Installed
> 802.1x Certificate Installed ‘:’
SRS Attribute
Event
Storage Refresh | | Save
System
Information
Figure 5-51
2. Click ACreatedo and it wild.l pop out the-52ialog box
HTTPs X
Country CN *e.g.CN
IP or Domain name | 10.15.15.211| 2
Validity Period 365 Day*Range :1-5000
Province none
Location none
Organization none
Organization Unit none
Email
Creat Cancel
Figure 5-52
3. Fi Il in correspondiongnilCesomer pdbhefiPiaviomenati on, ¢
It wil |l show the prompt of fACreate Successfullyo,

successfully created.
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Note:
Make sure the Al P or domain nameo is the same as th
4, Click nAlnstall o and it wi || instal/l the -83ertifica

IP camera
Camera
> TCPIP [T] Enable HTTPs
> Connection Create Certificate
> DDNS Request Created
> IP Filter

Request Created 1 B = L = Delete || ” Download
> SMTP(Email)
Install Signed Certificate

> UPnP
> SNMP Certificate Path
> Bonjour Certificate Key Path | )2 |
> Multicast Certificate Installed
e Certificate Installed  H/IP= =CN;ST =
288 Aftribute Issue to: HAP=10.15.15.211; C=CN; ST=none; 2

M L=none; O=none; OU=none; EN=; =
Event Issuer: HAP=test, C=CN; ST=test; L=test, O=test; -
Storage Refresh | | Save
System
Information

Figure 5-53
. ~ N . .
5, Click fADownl oado. It wi ||l pop out the dialog box
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Search Libraries pel

9.4

Organize ¥ &= - o
W Deskeop Libraries
& Downloads = Open a library to see your files and arrange them by folder,...
“C] Recent Places
Documents
\ 4 - Libraries ] Library
I 25| Documents
g J’ Music & Music
I (=] Pictures \/ Etbeany
13 I Videos P ;
IQ\L Pictures
= Library
48 Computer <
> &y Local Disk (C:) Videos
I = DISK1_VOL2 (D:) . g Library
I g DISK1_VOL3 (E:) iY;
File name: RootCert.cer v
Save as type: | "cer) 7]
(~ Hide Folders [ swve ][ Conce |
Figure 5-54
6. Double click the downloadedi con of HfARootCert.cero. The system w
nterface of ACertificabbed, which is shown in Fig
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' Certificate g

General |Detaiis I Certification Path

ba Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to: test

Issued by: test

valid from 2016/ 7/ 8 to 2020/ 7/ 7

IInstall Certiﬁcahe...] | Issuer Statement |

Learn more about e

[ o ]

Figure 5-55
7. Click Alnstall Certificatedo and it will pop out
shown in Figure 5-56.
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Certificate Import Wizard &

Welcome to the Certificate Import
Wizard

This wizard helps you copy certificates, certificate trust
lists, and certificate revocation lists from your disk to a
certificate store.

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections. A certificate store is the system area where
certificates are kept.

To continue, dick Next.

< Back [ Next > ] [ Cancel ]

Figure 5-56
8. Click ANexTroustSed eRdot Cer twhithiiscskown iroRgurdsissZ.hor i t i es 0
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Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
@ Place all certificates in the following store

Certificate store:
Trusted Root Certification Authorities l Browse.., l

Learn more about certificate stores

| <Bak | mext> | | cancel |

Figure 5-57
9. Click ANexto. The system will display the interfa
which is shown in Figure 5-58.
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Completing the Certificate Import
Wizard

The certificate will be imported after you dick Finish.

You have spedified the following settings:

Certificate Store Selected by User RIS a0l 48 g1 le
Content Certificate
4 ALl r

[ <Back [ Fnish | [ Cancel |

Figure 5-58
10.Cl i ck AFinishod, and it will pop out the dia39o0og bo
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Se:unty Warning
-

P — E

You are about to install a certificate from a certification authority (CA)
__IA claiming to represent:

test

Windows cannot validate that the certificate is actually from "test". You
should confirm its origin by contacting "test". The following number
will assist you in this process:

Thumbprint (shal): 6D811FD2 E82313A8 663514ED 2CA36E6B 7D425FA6

Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this
risk.

Do you want te install this certificate?

Yes No
Figure 5-59
11.Click AYeso. It will pop out the dialog box
certificate, which is shown in Figure 5-60.
B X Bl
Certificate Import Wizard g

4 R\
|0l The import was successful,
" 4

—

Figure 5-60
, Please refer to the following steps if you

of

s el

ect

1. Sel ect ASetup > Network > HTTPso0. The system wil/

in Figure 5-61.
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IP Camera

> TCPIP [C] Enable HTTPs

> Connection Create Certificate
> DDNS Request Created
> IP Filter
Request Created I i I l Download
> SMTP(Email)
Install Signed Certificate
> UPnP
> SNMP Certificate Path er.pe Browse...
s Bonjour Certificate Key Path Browse.. ][ Upioas |
> Multicast Certificate Installed
D802 1 Certficate Installed l:’
s
R Attribute
. HTTPs.
Event
Storage Refresh | | Save
System
Information
Figure 5-61

2. Select signed certificate and certificate key pat

3. Install root certificate, please refer to step 6~11 for more details.

4. Check AEnable HTTPso0, click ASaveod. Theebwotthad em wi
devicedo, and then the config is valid.

Reboot

A The configuration takes effect, the device is restarting now, please don't leave this page or close the browser...

Figure 5-62
5. Use HTTPs
Use HTTPs to log in.
Enter https://xx.xx.xx.xx in the browser, and it will pop out normal login interface; the browser will prompt
certificate error if the certificate is not installed, which is shown in Figure 5-63.
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https://xx.xx.xx.xx/

‘& Certificate E

~ @] https://10.1515.211/

File Edit View Favorites Tools Help

e Favorites | o [B B v ) MTTHEAE v

‘ (& Certificate Error: Navigation Blocked [ ‘

ﬁ@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server,

We recommend that you close this webpage and do not continue to this website.
@ Click here to dlose this webpage.

@' Continue to this website (not recommended).

® More information

Figure 5-63
Note:
AXX.XX.XX.XX0 is corresponding to your I P or domai n
5.3 Event
5.3.1 Video detection
5.3.1.1 Motion Detection
Step 1
Select ASetup > Hane MdtionsDetdtliodde oa nDde ttehcet system wi l | di

Mot i on D shichis shownm im&igure 5-64.
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IP Camera

Camera Scene Changing

Network

[C] Enable

| Video Detection |
o Working Period
> Audio Detection

Anti-Dither
> Smart Plan

5

e T
10
10

Second (0~100)

> Face Detection [¥] Record
> People Counting Record Delay Second (10~200)
> HeatMap [¥] Relay-out

> Alarm

Alarm Delay Second (10~300)

> Abnormality

["] Send Email
Storage
[] Snapshot
system
Information pefaut__ || Refiesn [ sawe

Figure 5-64
Step 2

Sel ect fi E n a bmow®on deteation éunctoh.| e
Step 3

Set motion detection area.

1. Click ASetupod and tt htehe yisrnteenr fwad @

pfopAdat ti ng Ar e
65
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Region E H =

Name ‘! Region1 ‘

Sensitivity (=) ————{_}——(3) 60
Threshold (&) {}——[@ 5

Figure 5-65

2. Setarea name, itis to set valid area of motion detection according to the actual situation, and it can
set the value of sensitivity and threshold respectively.
The bigger the sensitivity is, the easier it is to generate motion detection, the smaller the threshold is,
the easier it is to generate motion detection; the entire video image is the valid area of motion
detection by default.

Note:

Different colors represent different areas; each area can set different detection area.

The red line in the Oscillogram means triggering motion detection; green line means not triggering

motion detection.

3. Click ASaved to complete area setting.

Step 4

It is to set other parameters of motion detection, please refer to the following sheet for more details.

5
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click nASetypbemnawithepoep out the
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the

whole week, then it means the setup can be applied to the whole

week, you can also select the check box in front of the week number

to implement independent setting for some days).

3. Click ASaveodo to complete the set

5

Anti-dither

System only memorizes one event during the anti-dither period. The value
ranges from 0Os to 100s.

Area

1. Click ASetupo and the system wil

2. Setthe area name, it is to set the valid area of motion detection
according to the actual situation, and it can set its sensitivity and
threshold respectively. The higher the sensitivity is, the easier it is to
trigger motion detect, the smaller the area threshold is, the easier it is
to generate motion detect, the whole video image is the valid area of
the motion detect by default.

Note:

Different colors represent different areas; each area can set different

detection areas.

The red line in the Oscillogram means triggering motion detect, the green

line means not triggering motion detect.

3. Click ASaveodo to complete area se

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can sgnd out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs. Use

cansettherecor ded or upl oaded audi, oaudia, |

alarm audioa
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Parameter Function

Check it and the flash will be on when alarm occurs, and the flash will

Flash linkage ' -
be off until the end of alarm after corresponding delay.

PTZ . Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.

Snapshot You need to check the box here so that system can backup motion detectior

snapshot file. You shall set snapshot period in Storage>Schedule.

Step 5
Click ASaveo to c oaipnidetdcton.t he setting of

5.3.1.2 Video Tampering
Step 1

Sel ect ASetup > Hone Wideo Pampéiindoe oa nDde ttehcet syst em wi | |

AVideo Tamperingo whie6h is shown in Figure 5

IP Camera

Camera Motion Detection JVideo Tampering]| Scene Changing

Network
[7] Enable Video Tampering [7] Enable Defocus Detection

Working Period

> Smart Plan ] Record

> Audio Detection

N Record Delay 10 Second (10~300)
> Face Detection [¥] Relay-out

> People Counting Alarm Delay 10 Second (10~300)

7 HaNap ["] Send Email

> Alarm
[*] Snapshot

> Abnormality
Storage Default | ‘ Refresh | I Save

System

Information

Figure 5-66
Step 2
Set the parameter of video tampering; please refer to the following sheet for more details.
Parameter Function
Enable video You need to check the box to enable video mask detection alarm.
tampering

Enable defocus | You need to check the box to enable defocus detection alarm.
detection
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Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click fAiSetupo and the systemngwil
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the

whole week, then it means the setup can be applied to the whole

week, you can also select the check box in front of the week number

to implement independent setting for some days).

3. Click ASaveodo to complete the set

Check it and so when alarm occurs, system will auto record. You shall set

record period in Storage>Schedule and select auto record in record control

interface.

Working Period

5

Record

Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

System can delay the alarm output for specified time after alarm ended. The

Alarm Delay
value ranges from 10s to 300s.

Send Email If you enabled this function, System can ;end out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Audio linkage Check it and the system will play alarm audio file when alarm occurs._Use
can set the recorded or upl oadedb,
alarm audi oo0.

Flash linkage Check it and the flash will be on when alarm occurs, and the flash will

be off until the end of alarm after corresponding delay.
PTZ . Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
You need to check the box here so that system can backup motion detectior
snhapshot file. You shall set snapshot period in Storage>Schedule.

Snapshot

Step 3
Cl i ck #fSav e the getop ot vieopampeting.

5.3.1.3 Scene Changing

Step 1
Select ASetup > HonentScendi €CdanPenhgot and the system
iScene Changingodo whieh is shown in Figure 5
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IP Camera

Camera
Network
Event

Video Detection

> Audio Detection

> Smart Plan

> Ivs

> Face Detection
> People Counting
> HeatMap

> Alarm

> Abnormality

Motion Detection || Video Tampering | Scene Changing

[7] Enable
Working Period

[¥] Record

Record Delay 10
[v] Relay-out

Alarm Delay 10
[l send Email

"] Snapshot

Second (10~300)

Second (10~300)

Storage

Default | |

Refresh ‘ | Save

System

Information

Step 2
Check
Step 3

Figure 5-67

i En a b | tleedunctiom of scare bhanging.

It is to set the parameters of scene changing, please refer to the following sheet for more details.

Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click fiSetupo
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the

whole week, then it means the setup can be applied to the whole

week, you can also select the check box in front of the week number

to implement independent setting for some days).

3. Click ASaved to complete the set

and the system wil

5

Record

Check it and so when alarm occurs, system will auto record. You shall set
record period in Storage>Schedule and select auto record in record control
interface.

Record Delay

System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended. The
value ranges from 10s to 300s.

Send Email If you enabled this function, System can send out email to alert you when

alarm occurs and ends. User can set email address in Network>SMTP.
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Parameter Function

PTZ . Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.

. The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.

Step 4
Click ASavedo to complanaging the setup of scene <ch

5.3.2 Audio Detection
Step 1

Select ASetup > Hanénand ®thdi sydPeemcwi | | di spibnay t he
which is shown in Figure 5-68.

IP Camera

Camera Audio Detection
Network

ent [T] Enable InputAbnormal
Detection

["] Enable Intensity Change
<utiiioBetecion

> Smart Plan Sensitvity B8 0 2
> Vs Threshold = 0 50
> Face Detection
> People Counting
> HeatMap
> Alarm
> Abnormality
:;Z::'Q"e Working Period -Setup
Information HLRELE 5 Second (0~100)
V] Record
Record Delay 10 Second (10~300)
[v] Relay-out
Alarm Delay 10 Second (10~300)

["] Send Email

("] Snapshot

Default | l Refresh | ‘ Save

Figure 5-68
Step 2

It is to set the parameters of audio detect, please refer to the following sheet for more details.

Parameter Function
Enable input Select fAEnable I nput Abnormal 6 and
abnormal audio input abnormity.

Enableintensity | Sel ect #AEnabl e | nt ensi talarm@lheninhdgtects a
change that audio intensity change exceeds the threshold.

92



Parameter Function

Sensitivity It can be judged as audio abnormity when the input volume change
exceeds continuous environment volume; users need to adjust according
to the actual environment test.

Threshold It is to set the filtered environment volume intensity, if the environmental
noise is too big, then the value needs to be set higher, users can adjust
according to the actual environment test.

Note:

It is to set the alarm period, it can enable alarm event only during the

period range which has been set.

1. Click fAiSetupod and the system wil
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the

whole week, then it means the setup can be applied to the whole

week, you can also select the check box in front of the week number

to implement independent setting for some days).

3. Click ASavedo to complete the set

Anti-dither System only memorizes one event during the anti-dither period. The value

ranges from 0s to 100s.

Check it and so when alarm occurs, system will auto record. You shall set

Working Period

5

Record o .
record period in Storage>Schedule and select auto record in record control
interface.
Record Delay System can delay the record for specified time after alarm ended. The
value ranges from 10s to 300s.
Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended. The|
value ranges from 10s to 300s.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
PTZ . Here you can set PTZ movement when alarm occurs. Such as go to
preset x when there is an alarm.
The event type includes: preset, tour and pattern.
Snapshot You need to check the box here so that system can backup motion detectior
snapshot file. You shall set snapshot period in Storage>Schedule.
Step 3
Click ASaveo to complete the setup of audio detecti
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5.3.3 Smart Plan

Smart plan is the master switch for Heatl MapgentnhWsé

AfPeopl e Countingo and so on, the corresponding i nte
enabled.
Step 1
Select ASetup > Event > Smart Plano. The system wil
shown in Figure 5-69.
IP Camera
Camera Smart Plan
Network
> \;’xdeo. Detection
> Audio Detection
> Vs
> Face Detection
> People Counting | Refresh | \ Qo
> HeatMap
> Alarm
> Abnormality
Storage
System
Information
Figure 5-69
Step 2
Click ASavedo to complete the config of smart pl an.
5.3.4 Intelligence Behavior Analytics
The basic requirements of scene selection
. The total proportion of the target shall not exceed 10% of the image.
. Thetargetsizeintheimagecandt be | ess than 10 pixel 110 pixel
be less than 15 pixel x 15 pixel (CIF image); Thehei ght and wi dth of the tar

the image; it is recommended that the target height is about 10% of the image height.

Make sure the target appears at least over 2 seconds continuously in the field; the movement
distance has to be bigger than the width of the target itself and makes sure it is no less than 15
pixels (CIF image).

Try to lower the complexity of the monitoring scene analysis if it is possible; it is not advised to use
IVS functions in the environment where the targets are dense and light change is very frequent.
Try to keep away from the areas such as glass, ground reflected light, water surface, branch,
shadow, mosquito disturbance and etc.; try to keep away from the backlight scene to avoid direct
light.
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5.34.1IVS

5.3.4.1.1 Tripwire

It will trigger alarm when the target crosses the warning line according to the movement direction which
has been set.

It needs some time from when the target appears to when the target is confirmed, so it has to leave
some space on both sides of the warning line when setting the warning line, please do not set the
warning line near the obstructions.

Application scene: it can be applied to the scene with sparse target and there is barely any blocks
between the targets, such as the unmanned perimeter defense.

Step 1

Select ASerlWp>I¥SoOEwenmt t he system wil IVSodi spl ay the it
Step 2

Clic‘) it o set rule name and select the rul76. type as

IP Camera

Camera
Network

No. Rule Name
@ 1

Rule Type

Rule1 Tripwire

> EventManage
> Video Detection
> Audio Detection
> Smart Plan

> Face Detection

Parameter Setup

Working Period

Direction

> People Counting
> HeatMap A<->B

> Alarm
Object Track

> Abnormality
Storage
System

Information

Step 3

Click

Target Filter

® MaxSize 8191 * 8191

Min Size 0 =0

Draw Target

| Record

Record Delay

| Relay-out

Alarm Delay

| 8end Email

«! Snapshot

Second (10~300)

Second (10~300)

pefautt ||

Refresh | |
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It is to set the parameters of tripwire, please refer to the following sheet for more details.
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Parameter Function
Object tracking Select AObject trackingo to enabl e
Adjustmentd for more details.
Note:
The function is only supported by some models.
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fiSetupo
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. Click ASaveodo to complete the set U

and the system wil/

B

Direction

It is to set the direction of tripwire, you can select A->Ba B->Aa A<->B.

Object Track

Sel ect AObject Tracko and it wildl
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camer a. Pl ea
for more details.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select ASnapshotdo and the system w
alarm occurs.
Step 5
Click ASavedo to complete the setup of tripwir

5.3.4.2 Intrusion
Intrusion includes cross and appears.

e.
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Cross means that it will trigger alarm when the target enters or exits the area.

Appears means that it will trigger alarm when the target appears in the area.

As for the report interval of the IVS function in the area, the system will trigger an alarm if it detects
same event happened during the interval; the alarm counter will become zero if there is no same
event happened in the interval.

It needs to leave some space for target movement for the area periphery if it is to detect enter & exit
event, which is similar to the warning line.

Application scene; it can be applied to the scene where the target is sparse and there is barely any
obstruction between the targets, such as the unmanned perimeter defense.

Step 1

Select ASet ¥Wp>I¥SoOEwemt t hel system wi lAvSod.i spl ay the it
Step 2

Clic‘) it o set rule name, select the rule7Lype as Al

IP Camera
Camera
Ratwork No. Rule Name Rule Type L
= (@ 1 Rulet Intrusion v @
> EventManage
> Video Detection
> Audio Detection
> SmartPlan
@ Z g “Tocll. i " -Parameter Setup—
% Eace Delucion ) b il : . WorkingPeriod
> People Counting i = £ i
> HeatMap . ‘ : 1 { NS 5| Action Appears ¥ Cross
PR ¢ Direction Enter&Exit X
> Abnormality B> e .
Storage G A Object Track
system - w0 Record
Information Record Delay | 10 Second (10~300)
TargetFilter (o MaxSize 8191 |* 8191 Draw Target Relay-out
— e Alarm Delay | 10 Second (10~300)
Send Email
v/ Snapshot
[ Detaut || Retiesn ][ sawe
Figure 5-71
Step 3
Click nADraw Ruledo to draw an area in the monitoring
Step 4
Click ADraw Target o t o ditargetinthekideoismage.e model of filte
Step 5

It is to set the parameters of intrusion, please refer the following sheet for more details.
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Parameter

Function

Object tracking

Select AObject trackingo to enabl e
Adjustment 6 f or more detail s

Note:
The function is only supported by some models.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fiSetupodo and theesfyatemofi AW
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. Click ASaveodo to complete the set U

B

It is to set the action of intrusion, you can select appears and cross.

Action

Direction It is to set the direction of intrusion, you can select enter, exit and
enter&exit.

Object Track Sel ect AObject Tracko and it wildl
moving object triggers rule and generates alarm, it will select the display
mode of object track such as 1P+3 or 1P+5 in the preview interface, the
scene of tracking window will follow the moving object till the object leaves
the view range of the camera. Pl ea
for more details.

Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select hv$mwmamgsand the system will aut
alarm occurs.
Step 5
Click ASaved to complete the setup of intrusi

on.
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5.3.4.3 Abandoned Object

Abandoned object means the system will trigger alarm if the abandoned object in the monitoring scene
exceeds the time which has been set by the users.

Abandoned object and missing object can be confusing in a situation where both foreground and
background are complicated.

It also triggers alarm as abandoned object if there is pedestrian or vehicle staying still for too long. In
order to filter this kind of alarm, generally the abandoned object is smaller than people and vehicle;
therefore it can filter the people and vehicle via setting size. Besides, it can avoid the false alarm caused
by short stay of people via extending alarm time properly.

Application scene: It can be applied to the scene where the target is sparse and there is no obvious and
frequent light change. False alarm will be increased in the scene with high target density and frequent
blocking; false alarm will be increased in the scene where there are more people staying. As for the
detection area, try to make it simple, the function is not suitable for the area which is too complicated.
Step 1

Select ASet ¥p>I¥SoEweamtytsh elm wi I | di splV®y the interf a

Step 2

Clic‘) it o set rule name, select the rule typer2as

IP Camera

Camera

Network &
2015-93-31 134150 No. Rule Name Rule Type
® 1 Ruler Abandoned Ob[~| @ *|

> Video Detection

> Audio Detection

> Smart Plan

s | T :

> Face Detection B Rl Y [/ A Parameter Setup

> People Counting = i i, Working Period

> HeatMap |

A g Keep Time 10 Second (6~3600)

> Abnormality

Storage [7] Record

System c i~—~— B — Record Delay | 10 Second (10~300)

Information [] Relay-out

Alarm Delay 10 Second (10~300)
TargetFilter  © Max Size = [T SendEmail
©) Min Size - [ cear ] @) Snapshot
| Default H Refresh || Save
Figure 5-72

Step 3
Click ADraw Ruleo to draw an area in the monitori
Step 4
Clickv ATlarraget 6 to draw the size model of filtered
Step 5

9¢

A

no

t



It is to set the parameter of abandoned object, please refer to the following sheet for more details.

Parameter Function

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fiSetupod and the system wil!|l
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

3. Click ASaveodo to complete the set U

It is to set the shortest time from when the object is abandoned to when it

Working Period

5

Keep time ,
triggers alarm.

Record Check it and so when alarm occurs, system will auto record.

Record Delay System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can s&_end out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select ASnapshotd and the system w
alarm occurs.

Step 5

Cl i ¢ k #f S aplet the setop ot abandoned object.

5.3.4.4 Missing Object

Missing object means the system will trigger alarm if it exceeds certain amount of time after the target is
taken away from the original scene.

The system can make statistics of the still areas in the foreground area and distinguish if it is missing
object or abandoned object according to the similarity between foreground and background, it will
trigger alarm when it exceeds the time which is set by users.

Because the system distinguishes abandoned object from missing object according to the similarity of
foreground and background, it may cause error between abandoned object and missing object in a

situation where both foreground and background are complicated.
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Application scene: it can be applied to the scene where the target is sparse and there is no obvious and

frequent light change. False alarm will be increased in the scene where the target density is high and

there is frequent obstruction; the false alarm will be increased in the scene where there are more people
staying. As for the detection area, try to make it simple, the function is not suitable for the area which is
too complicated.
Step 1

Sel

ect fASet YP>I¥SOEwenmt t hel system wil IVSod.i spl ay

Step 2

t he

CIickc‘) to set rule name and select rule typ#3 as

Network
20150001 13:41:50 G e SO i
- 1 Rulel Missing Object[~| @ *
> Video Detection |
> Audio Detection
> Smart Plan
. .
> Face Detection R..1 “H e B < [ Par Setup
> People Counting Working Period
> HeatMap { 1
P = Keep Time 10 Second (6~3600)
> Abnormality = Z
Storage [] Record
System Record Delay | 10 Second (10~300)
Information ( [7] Relay-out
NamDeay |10 Second (10-300)
TargetFilter @ Max Size 1 = 1 [C] send Email
©) Min Size . ,m Snapshot
[ peaut || Rewesn ][ sae
Figure 5-73
Step 3
Click ADraw Ruledo to draw an area in the moni
Step 4
Click ADraw Targeto to draw t hdeoimagezee model of
Step 5

IP Camera

Camera

It is to set the parameters of missing object, please refer to the following sheet for more details.

tor
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Parameter

Function

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fiSetupd and the system wil!|l
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

B

3. Click ASaveodo to complete the set U

Keep time

It is to set the shortest time from when the object is missing to when it
triggers alarm.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select ASnapshotd and the system w
alarm occurs.
Step 5
Click ASavedo to complete the setup of missing

5.3.5 Face Detection

Step 1

Select ASetup > Event > Face Detectiono and th
which is shown in Figure 5-74.

e

10z

obj ec

syst



IP Camera

Camera Face Detection

Network [V] Enable
> Video Detection Working Period
> Audio Detection
[”] Enable Face Enhancement
> Smart Plan
[7] Record
. Face Detection Record Delay 10 Second (10~300)
> People Counting [ Relay-out
> HeatMap Alarm Delay 10 Second (10~300)
> am [] Send Email
> Abnormality
V| Snapshot
Storage
System
) =k [ peaut [ Reesn |[  sae
Information
TargetFilter @ Max Size 2
) Min Size "
Figure 5-74
Step 2
Select AEnabled to enable face detection functi
Step 3
Click ADraw Tar get 0 oftasgetfliteranihe vide®imagé. ze mode |l
Step 4
It is to set the parameters of face detection, please refer to the following sheet for more details.
Parameter Function
Note:

Working Period

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fiSetupodo and the system wild/l
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

5

3. Click ASaved to complete the set
Enable Face Select fAEnabl eneffa ®e aBhancevi | | gua
Enhancement clear by priority when the stream is set very low.
Record Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.
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Parameter Function

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.

Alarm Delay System can delay the alarm output for specified time after alarm ended.

Send Email If you enabled this function, System can s<_end out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.

Snapshot Select ASnapshotd and the system w
alarm occurs.

Step 5
Clickonsaveomplete the setup of face detection.

5.3.6 People Counting
5.3.6.1 People Counting

Step 1
Select ASetup > EverPeopleCobnéingdp | &n dCotulme i ;ygs t>em wi | | di
of AEntrance/ Exito, which is shown in Figure 5
[P Camera
Camera
f‘fEfWOYK 0 \ [¥] Enable
> Video Detection 3 e - @] Enable 0SD
> Audio Detection el L~ . ;
> SmartPlan 51 ¥ . ! i g% s Working Period
> Vs : } Lens Direction Inclined [+]
> Face Detection |
4 Rule Name NumberStat
. . / 2 . % ; 3 Direction A->B E
> Hea W 4 i % g
> Alarm W= x ! Rt ! Flowrate Alarm
> AbrionTaiy 2 By 2 Enter Number 0
Storage 7 it L Leave Number 0
system N gt o Stranded Number | 0
Information sy S e A
- Record Delay 10 Second (10~300)
TargetFilter © Max Size i [] Relay-out
ENESeal 73 [ 97 (e 2ol Alarm Delay 10 Second (10~300)
[C] Send Email
[v] Snapshot
Default | | Refresh I | Save
Figure 5-75

Step 2

Sel ect AEnabl ed to enable statistics function of en
Step 3

Click ADraw Ruleo to draw an area in the monitoring
Step 4
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Click ADraw Targeto to draw the size model of
Step 5
It is to set the parameters of entrance and exit, please refer to the following sheet for more details.
Parameter Function
Enable OSD Select AENnabl e OSDOo peaptediunmbdr statistids bf d i

entrance and exit in the monitoring image.

Working Period

Note:

It is to set the alarm period, it can enable alarm event only during the period

range which has been set.

1. Click fASetupo
Periodo.

2. ltis to set working period according to the following methods:

You can input time numerical value or press the left mouse button to

drag on the setup interface to set.

There are six periods to be set every day, select the check box in front

of the period, and then the period is valid.

Select week number (it selects Sunday by default, if it selects the whole

week, then it means the setup can be applied to the whole week, you

can also select the check box in front of the week number to implement

independent setting for some days).

and the system wi

3. Click ASaveodo to cworkipglperibpde t he se
Installation It is to select wall mount if there is an angle between device lens and
Mode horizontal surface, select ceiling if the device lens face downward vertically.
Rule Name It is to set the name of rule.
Direction It is to select the direction of entrance and exit statistics; A->B or B->A, the

arrow direction always means the entrance direction.

Flowrate Alarm

It is to set the enter number, leave number, stranded number; it will trigger
alarm when it exceeds the limited humber.

Record

Check it and so when alarm occurs, system will auto record.

Record Delay

System can delay the record for specified time after alarm ended.

Relay out Enable alarm activation function. You need to select alarm output port so
that system can activate corresponding alarm device when alarm occurs.
Alarm Delay System can delay the alarm output for specified time after alarm ended.
Send Email If you enabled this function, System can send out email to alert you when
alarm occurs and ends. User can set email address in Network>SMTP.
Snapshot Select ASnapshotdo and the system w
alarm occurs.
Step 6
Click ASaveo to cpeoplpdoenting. t he setup of

5.3.6.2 Report
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It is to generate a form of report according to the number statistics.

Step 1

Select ASetup > Event > People Counting > Report fa
which is shown in Figure 5-76.

IP Camera

Camera People Counting

Network
= Report Type  Day El

> Video Detection Start Time | 2016-05-23 00 EndTime |2016-05-23 16 : +Daily Report Max Range Is 24 Hours.

> Audio Detection
> SmartPlan Flow Direction [v] Enters (V] Exits [v] Display Number Report Type @ BarChart () Line Chart

> Ivs
(i
> Face Detection
Eeopie Counting,
> HeatMap
> Alarm
> Abnormality

Storage

System

Information

Figure 5-76
Step 2
It is to set search condition, please refer to the following sheet for more details.

Parameter Note

Can select day report, month report and year report; also can select bar chart or line

Report Type chart to display the report.

Time It can set the begin /end time within the range of statistics time.

It can select enter, leave and display number; the data of checked item can be

Flow Direction displayed in the report.

Search Search flow statistics data according to the setting to form report.
Export Export the saved report.
Step 3
Click aSearcbompl ete report statistics, click AExpor

5.3.7 Heat Map

5.3.7.1 Heat Map

It is the density statistics of moving object that can generate report, the color range is from blue to red,
blue means the min heat value and red means the max heat value.

Mirroring, view angle change and heat map original data will be cleared.

Step 1
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Sel ect f
which is shown in

IP Camera

Camera

Network

> Video Detection
> Audio Detection
> Smart Plan

> Ivs

> Face Detection

> People Counting

> Alarm
> Abnormality

Storage

System

Information

Setup >

Figure 5-77.

Event

>

He at Map >

[v] Enable

Working Period

Heat Mapo

Detaut_] [_roresn ] [_sawe
Figure 5-77

Step 2

Sel eEmtabil ed to enable heat map function.

Step 3

It is to set the working period.

1. Click ASetupodo and the system will display
5-78.
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Working Period

0 2 4 g 8 10 12 14 16 18 20 22 24

N sy NN NN NN NN NS SR
Wednesday m
sy [ e

carts: . E————————————
e

[ an ¥ sunday I monday I Tuesday I~ Wednesday I Thursday I Friday [T Saturday
¥ Period®: | 00 : 00 : 00 |- 23 : 89 . 59 |
[ Pericd | 00 : 00 : 00 |-| 23 : 59 : 59 |
[ Pericd3 | 00 : 00 : 00 |-| 23 : 59 : 59 |
I Period4 | 00 - 00 : 00 |- 23 : 59 - 59 |
[ Pericds: | 00 : 00 : 00 |-| 23 : 59 : 59 |
I Pericdd | 00 : 00 : 00 |-| 23 : 59 : 59 |
| Save || Cancel |
Figure 5-78

2. ltis to set working period according to the following methods:

. You can input time numerical value or press the left mouse button to drag on the setup interface to
set.

. There are six periods to be set every day, select the check box in front of the period, and then the
period is valid.

. Select week number (it selects Sunday by default, if it selects the whole week, then it means the
setup can be applied to the whole week, you can also select the check box in front of the week
number to implement independent setting for some days).

3. Cl i ck fASav e the getop otvworkipglperibde t

Step 4
Click ASaved to complete the setup of heat map.

5.3.7.2 Report

It is to generate the form of report according to the heat map data.

Step 1

Select ASetup > Event > Heat Map > Repeorotfo fAaRred otrhed
is shown in Figure 5-79.
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Figure 5-79

Step 2

It is to set begin time and end time.

Step 3

Click ASearcho to complete report
5.3.8 Alarm

Please note some series products do not support this function.
5.3.2.1 PIR alarm

The alarm activation interface PIR alarm is shown as in figure 5-80.
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